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Conventions

Keywords, command buttons and other such fields are enclosed in “ “while being bold (for example,

to denote “Next” is used)

Inputs for commands and Variables are shown in Italics

File names and paths are shown in bold

Commands are shown in Courier new font

Mandatory keywords, arguments and inputs are enclosed within <>.
Optional arguments are enclosed in [ ]

“!Lr'} Notes:

Contain suggestions or tips.

!
"% Caution:

Contains critical information




1 How this solution works

1.1 Concept of failover failback

With rise in the number of File server users, the need to address the risk of downtime has become a
priority. This risk can be addressed through Scout file server solution. This is possible by failing over to
the DR server while the production file server is down. The following picture shows failover of a
production file server to a DR server.
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Figure 1:

Rather than just maintaining a backup, the DR server can replace the production server during outage.
All the shared folders, files will be shared on the DR server as well. This failover process will be
transparent to the end users. Once the production server has recovered from the outage a failback can
be performed which again is end user transparent. Please note that Hitachi Dynamic Replicator -
Scout does not currently support fabric-based solutions.
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Figure 2:

1.2 Protecting File server

File Server can be protected in two different ways i.e. FX agent services running under Domain user or
Local System account. File server is protected in four steps i.e. Discovery, VX Replication, Consistency,
and Recovery. Before protecting a file server determine if the FX agent is going to be started with a
special user as explained in Privileges for File server failover and failback section on page 14 or local
system account. (Refer section Determine FX Agent Service User on page 12.

When FX agent is started with local system privilege then an additional step is performed while
protecting the file server

Recovery
Discovery —=| VX Replication —= Consistency  —= (Failover &
Failback)
Figure 3
Discovery

After the volumes are replicated, perform a discovery job. This will scan the production server for all
the “shared” information and restore it on the DR server.

VX Replication
In this step the production file server volumes are replicated to the DR file server with CDP retention

enabled. Only the shares/folders on the replicated volumes are protected.

Consistency
File system consistency tags are issued at regular intervals through the FX job which internally calls the

vacp.exe on the production server.

Recover
File Server can be recovered either through Planned Failover, Un-Planned Failover and Failback.

1.3 File Server failover

There are two types of failovers; the first is a planned failover where the production server is prepared
for a failover and then a failover is performed. The second is an unplanned failover where the
production server is not considered (assuming that the production server is unreachable). Both types of
failovers may be performed either through FX jobs (CX UI) or through CLI
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Figure 4

A planned failover is primarily used when the production exchange server and the CX server both are
reachable by the DR exchange server. An ideal example is a logical corruption on the production server,
DR drills or any planned outages.

An unplanned failover on the other hand is performed when:
e The production server is unreachable and CX server is up and running
e The production server and the CX server are both unreachable

Differences between planned and unplanned failover

Table 1: Differences between unplanned failover and planned failover

_ Unplanned failover Planned failover

Real-time outages or Mock drills, To test the setup.
unexpected outages Any expected outages
Recovered to To latest consistent tag Issues a consistency tag on the
common for all file server File server volumes. Target is
replication pairs recovered to the same consistent
tag.
Yes, unless the CXis down.  Yes
Yes Yes




1.4 File server failback

Prepare (specific to
FX with domain
administrator

privilege)

— Reverse replication —3» Discovery 2 Failback

Figure 5

Prepare
A failback is performed when the production server is back online and ready to take over from the DR

file server. The FX agent refuses to start post failover when it is configured with domain administrator
privileges. This is because the host SPN entries are missing on the production server. You may add the
host SPN entry back to the production host in this step.

Reverse replication

A reverse replication is performed to update the production server with all the data changes occurred
during its outage.

Discovery
After data replication, proceed to perform a discovery to sync the latest shared folder information

Failback
A failback is performed through the FXjob. This will restore the production server back to its original
state with all the data and shared updates.



1.5 FXtemplates involved

Name of the template When is it used

- -.

FileServer To issue file system After the VX replication  Consistency is

Consistency consistency tags on pair has reached required at least

the production differential Sync once to perform an

volumes unplanned failover
at a later time

FileServer Failover
Without Retention

File server planned To perform a planned Used after a failover
Failback Failback

File server planned

Failover

SIS LRI ENL M To perform an When the production Ensure that you
Failover unplanned failover server is down select the source
and target as the
DR server when the
production server
is down



2 Prerequisites

e Ensure that firewall is not blocking any of the Scout components

e Ensure VX agents are installed on both the source and target hosts

¢ Install CX configuration server within the same LAN as of the source host

¢ Point all Process servers, VX, FX agents to the same CX server and assign appropriate licenses.

e FXagent may be started with Domain administrator privileges or Local System account. The table
below shows the differences in the steps to be performed when FX is running under domain
administrator privileges or with local system privileges.

11



2.1 Determine FX Agent Service User

FX agent may be started with Domain administrator privileges or Local System account. The table
below shows the differences in the steps to be performed when FX is running under domain
administrator privileges or with local system privileges. When the FX service is configured to run with
local system privileges, you will need to enter the domain administrator credentials or the special user
created under the section Privileges for File server failover and failback on page 14. Refer section
Storing Domain User Credentials (EX up with local system account) on page 13.

Table 2

Phase of solution | FX up with Domain FX up with Local System privileges
administrator privileges

Protecting File server is protected in three File server is protected in four steps:
steps: e VXreplication
e VXreplication e Discovery
e Discovery o Consistency
e Consistency e Store encrypted domain credentials

through winop.exe.

Failover No need to edit the FX job setting  Need to append the source prescript and
target post script with the
“—useuseraccount” switch

Failback After failover, add the SPN The failback FXjob’s source prescript and
entries back to the production File target post script need to be appended
server from DR File server with the “—useuseraccount” switch

through winop.exe

.
\!l) Notes:

While performing a failover or a failback through CLI, you may use —failover with the —ip switch
Or
Use the —failback switch

\l> Caution:

For clustered environment, always run the FX service with domain administrator privileges.

12



2.2 Storing Domain User Credentials (FX up with local system account)

This step is required only when the FX agent is configured to run with local system account privileges.
Access the production file server’s command prompt, and then navigate to the VX agent installation
path to issue the following command

Winop security —encrypt

You will be prompted for three inputs, the domain name, domain user name and corresponding
password.

C:wProgram FilessInMage Systems>winop security —encrypt

Enter Domain name:bhit32

Enter Domain User:administrator
Enter Password:

Reenter Password:

C:sProgram FilessInMage Systems>

Figure 6

"!I‘J Notes:

The user name entered here should either be the special user created under the section Privileges
for File server failover and failback on page 14 or the domain administrator.

Similarly repeat the same process on the DR file server. Whenever this user’s password changes, ensure
that you repeat this step on both the production and DR file servers.

13



2.3 Privileges for File server failover and failback

2.3.1 Introduction

The FX agent plays a critical role while performing a failover or a failback. It is important that the FX
agent on both production and DR servers have appropriate privileges. It is always recommended that
you create a special user with appropriate privileges and start the FX agent with that user’s privileges.

This part describes the process to create a user with appropriate privileges require for the FX agent to
start. It also describes the granular permissions required to allow the InMage service to successfully
perform a file server failover and failback. To set privileges you need to create domain user first then
full control over the DNS for each source and target. The process involved is:

e Create a Domain User

e Add this domain user to the Production Server and DR Server record in DNS Server management
console to give local administrator privileges.

e Add this user to Production Server and DR Server in Active Directory using ADSI Edit and give
full permissions.

"!L(J Notes:

You will need domain administrator privileges for following the steps given below.

Detailed procedure to set privileges is as follows.

14



2.3.2 Create a Domain User

Step 1. Log on to the domain controller as a domain administrator where Production Server and DR
Server are part of the domain.

Step 2. Click on “Start->Programs->Administrative Tools ->Active Directory Users and Computers”.

r“ Brograms

k e’@ Active Directory Domains and Trusts

54 Docurnents L4 ] ﬁ Active Directary Sites and Services
' -.? Active Directory Users and Computers |

Figure 7:

Step 3. You should now see the “Active Directory Users and Computers” window. Under “Active
Directory Users and Computers”, select “Domain Users”, a list of users appears on the right hand
side, right click, and select “New->User”.

4 Active Directory Users and Computers

@ Flle  Action Yiew Window Help
e B@EeFnR @ afhvasn
@ Active Direckory Users and Computer | Users 45 abjects
D Saved Queries Marme  / Tvpe | Description
=) braz.org € Activel User
- % Buikin € Activez User
b Comp?.lters € Administrator Delegate Contral. ..
-] Domain Controllers !ﬁcart Publishers Find
-] ForeignSecurityPrincipals F ind..
{2 Loadsim Users ] c|52 Computer
s
-3 Users oot Contack All Tasks 4
Grau
€ ooz iy Refresh
InetOrgPerson
b Query-based Distribution Grouy EEEi
mDnsAdmms MSMY Al "
ﬁansUpdateProxy [SEIETSELES e '
Printer
0 s e
s
Daomain Camputers —
ﬁz P Shared Folder U s
ﬁanmam Controllers Propetties
mDDma\n Guests
access to the computer/do. .
€T Domain Users £

Figure 8:

Step 4. You should now see the “New Object-User” screen. Enter the “Name” and “User Logon
Name” then click on “Next”. For this example “InMageUser” is used for first name and user logon
name.

New Object - User x

g Create in.  bit32.org/U zers

First name: IInM agellser Initials: I

Last name: I

Full name: IlnM agellzer

User logon name:
IInM agellser I (@hit32.arg j

User logon name [pre-windows 2000
[BITaz, [Inageliser

< Back I Mest » I Cancel

Figure 9:
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Step 5. Enter the “Password” and enable the “Password Never Expires” check box. A dialog box
appears indicating that you will not be required to change the password at next logon, click on
“OK” then click “Next”.

New Dbject - User x|

ﬁ Create in:  bit32 org/Users

Password: Iu----n

LConfirm pagssword: Iu----n

v User must change password at nest logon

™ User cannot change passwerd

Active Directory =

You spedified that the password should never expire.
The user will not be required ko change the passwaord at next logon.

¥ Paszword never expires

I Account is disablad

< Back Mewt » Cancel

Figure 10:

Step 6. You should now see the user name details and click on “Finish”.

New Object - User S|

g Create in:  bit32 org/Uzers

“when you click Finigh, the following object will be created:

Full name: Inkd agell ser ;I
User logon name: Intd agellsenzibit32. ong

The pazzword newver expires.

I]

< Back

Cancel I

Figure 11:



2.3.3 Permission for DNS Record Change

Step 1. Click on “Start->Run” then type “dnsmngmt.msc” and hit enter. You should see the DNS
management screen. Expand the “Domain” then right click on the production host to click on the
“Properties”.

_i._ dnsmgmt - [DNS\QA-BIT32-DC\Forward Lookup Zones',bit32.org]

,E_‘ File Action ‘iew ‘Window Help

e EE XSRS

2 ons hit3z.org 339 record(s)
= oe-Brraz-nc T
D Cached Lockups Filaserver
L——_H:I Forward Lookup Zones E] FileServert
-- _msdes bik32.org FileServer
{5 iz,
E‘ " ! nf;gcs filesharenm
% Taites E] imit2sn2a
0 wp
& :udp imits-| Delete

{1 DomainDRsZones imitsll properties
: B0 ForestDnsZones =] imibsl —————————
-G TEST.COM imitsn__Help

- Reverse Lookup Zones m@l FS-Mode2
Figure 12:

Step 2. You should see the source host properties screen. Click on the “Security” tab. Click on “Add”.

imits035 Properties I E=

Host [&] Security |

Group or user names;

‘ drn |
m Authenticated Users
ﬁ Domain Admins (BT 3240omain Admins]
!ﬁ Enterprize Adming [BIT32\Enterprize Admins]

ﬁ EMTERPRISE DOMAIN COMTROLLERS
o [
Add.. | Remaove |
Permizzions for Adminiztrators Al Deny
Full Cantral O O
Read O
wirite: O
S pecial Permizsions O

For special permiszions or for advanced settings, Advanced |
click Advanced. —
Ok I Cancel | Apply |

Figure 13:
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Step 3. You should see the “Select Users, Computers, or Groups” screen. Select the domain user name
(InMageUser) created in the previous steps and check if this username is available or not by
clicking on the “Check Names”. Click on “OK”".

Select Users, Computers, or Groups ed

Select this object type:

IUsers, Groups, or Built-in security principals Object Types. .. |

From this location:

Ibit32. org Locationg. .. |

Enter the object names to select [examples):
Inkdagellser [Intd agellsen@bit32 og LCheck Mames

Advanced... | ak. | Cancel |

Figure 14:

Step 4. You should be able to see the previous screen. Click on “Full Control” check box. Click on
“OK”. Repeat the same process for the DR server

imits035 Properties ed |

Host [&] Security |

(Group or User names:
€ MITSO35E [BITI2UMITS035E) ;I
€} inmage [inmage@®hit3Z org)
ﬂ Intd agellzer (Inkd agekd zeri@bit 32, org)
ﬁE Pre-windows 2000 Cl%patible Accezz [BIT325Pretwindows 2D...J
-

£ SrSTEM

Add... | Bemove |

Permizzions for [nkagel)ser Al Drery
Full Cantral O
Fead O
Wirite O
Special Permizzions O O

For special permiszions of for advanced settings., Advanced |
click Advanced. —

QK I Cancel | Apply |

Figure 15:

‘!Ll) Notes:

In Cluster case, you need to select the network name (Virtual Server Name) and give DNS
privileges by repeating steps 1 to 4.
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2.3.4 Permission for AD Changes

Step 5. Click “Start->Run->MMC”, select “Add/Remove Snap”-from File Menu, and Click on “Add”.

File  Action Wiew Favorites  Window  Helo

Add/Remove Snap-in
= = |m|B| 2
o Standalane | Extensions |
i Console Root
4 Console Root Use this page to add or remove a standalone Snap-in from the

Snap-ins added ta: Ia Console Root

i~ Description

Add.. | Bemove Abot.,. |

Ok

Figure 16:
Step 6. You should see an “Add Standalone Snap-in” screen, select “ADSI Edit”, and click on “Add”.

Add Standalone Snap-in 2=l

Awailable Standalone Snap-ins:

Snap-in | Yendor | -
5‘& MET Framework, 1.1 Configuration Microzoft Corparation
eE."—"«ctive Directory Domaing and Trusts  Microzoft Corporation
ﬁ!—\ctive Directory Sites and Services  Microzoft Corparation
@Active Directory Uzers and Comput...  Microzoft Corporation

g&l!—\ctivﬂ Cantral Microzoft Corporation

W Microzoft Corparation
Autharization b anager Mizrozoft Corporation

Certifizate Templates Microzoft Corparation

@ Certificates Mizrozoft Corporation

@i Certification Autharity Microzoft Corparation ;I

[ =

- Diezcription

& low level Active Directory Services Interface editor.

Add Close

Figure 17:

"EI‘) Notes:

You need to install “ADSI Edit” before you add it in “Add Standalone Snap-in” (This is
available in Windows Support Tools)
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Step 7. You should be able to see “Add/Remove Snap-in” screen and click on “OK”.

Standalone | Extensions I

Uze thiz page to add or remove a standalone Shap-in from the conzole.

Snap-ing added to: Ia Conzole Foot j

< ADS| Edit

— Descrption

Bemove About,. |

(]4 | Cancel

Figure 18:

Step 8. You should be able to see “console” screen. Select “ADSI Edit”, right click, and click on
“Connect To”.

"Hi Consolel

File  Action Wiew Fawvorites  Window

¢ = | AERE| 2

'fii Console Rook', ADSI Edit

[ Consale Roaot

< IR

Conneck k..,

Wiew k
Mew Mindow From Here

Mew Taskpad Yiew. ..

Refresh
Expork Lisk, ..

Help

Figure 19:



Step 9. You should be able to see “Connection Settings” screen. Select domain from “Select a well
known Naming Context” or “Domain” and click on “OK”".

Connection Settings E

Tame: I Domain

Path: ILD.C\F‘:,l',l'imitsEll2.xiotechxsr\-’r.net,l'Du:nmain

- Conneckion Poink
" Select or bype a Distinguished Mame or Maming Context:

| =l

% Select a wel known Maming Context:

Campuker

" Select or bype a domain or server:
| i

' Defaulk (Domain or server that you logged in ko)

Advanced. .. | (a4 I Cancel |

Figure 20:

Step 10.Select the domain user name (InMageUser) under “Domain” in the console root screen.

'Hi Console Root' ADSI Edit',Domain [QA-BIT32-DC.bit32.0rg]DC=hit32,DC =org',C 1ol =l
7 Cl=exl m | Distinguished MName

H-C0 Ch=exz

i Ch=exzkiuserl
-1 Ch=Exchange Do
73 Ch=Exchange Ente
:I--[:l ZN=expagal

:I--[:l CN=expagaZ

71 CN=EXUSER

A | Ch=Group Policy ©
71 CN=gtest2

- Chu=Guest

- CH=IIS_wPa

-1 CM=inmage

D CN=InMagellser
-2 CH=TUSR _CLUSTEF
-0 CN=TWAM_CLUSTE
&0 ch=krbigt

-0 CH=nitin -

4| | » 1| | ol
Figure 21:

There are no ikems o show in this view,
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Step 11.Right click and click on the “Properties”. You should be able to see the “Properties” screen and

click on “Security Tab”.

CN=InMageUser Propetties 2 x|

Atibute Editor - Securiy |

Group or user names:

m Account Operators [BIT 3248,

Operators)

Coount

ﬂz Authenticated Users %
ﬂz Cert Publishers [BIT 324Cért Publishers)

!ﬁ Domain Adming [BIT 325\Dormain Adming)

Add... | Bemaove |
Permizgions for Adminigtrators Allow Deny
Full Cantral ﬂ
Read
WTite

Create All Child Objects
Delete All Child Objects
Allowed to Authenticate

EO0EEEO
Ooooooo

For special permizzions or for advanced settings, Advanced |
click Advanced. =

Ok I Cancel | Spply |

Figure 22:

Step 12.You should see the “Select Users, Computers, or Groups” screen. Select the domain user
(InMageUser) created in the previous steps and check if this username is available or not by
clicking on the “Check Names”. Click on “OK”.

Select Users, Computers, or Groups S|

Select this object type:

IUsers, Groups, or Built-iT securty principals Dbject Types...

From thiz location:
Il:uit32. arg Locations...

Enter the abject names to select [examples]:
Intd aqellzer [Inbd agellzerf@hii3z. org)] Check Mames

i

Advanced... | 0K | Cancel |

Figure 23:

2l
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Step 13.You should see the previous screen. Click on “Full Control” check box and click on “OK”.

CN=InMageUser Properkties ﬂ x

Atibute Editor - Securty |

Group ar uzer narmes:
tﬂ EMTERPRISE DOMaIM COMTROLLERS ;I
tﬂ Everone
ﬁ Euchange Enterprize Servers [BIT32\Exchange Enterprize Serv... J
ﬂ inmage [inmagel@bit32 org)

ﬂ InM agel zer [Inkagel) zen=bit32 org)

=l
.

RN i R T L
Add.. | Bemove |
Permiszions for Inkd agell ser Allow Derny
Full Cantrol ﬂ
Read
Wirite

Create All Child Objects
Delete All Child Objects
Allowed to Authenticate

OooOooon

For zpecial permizsions or for advanced settings,
click &dvanced.

Advanced |

o ]

Cancel | Apply

Figure 24:

Step 14.You should see the console screen, select the “Production Server”, right click, and click on the

“Properties”.
"fii Console1 - [Console Root',ADSI Edit',Domain [QA-BIT32-DC.bit32.0rg]}DC=bit32,DC=org CN=Co ;IEIi”
Bﬁ] File Action ‘iew Favorites  Window  Help |;|i|1||
cs | EEXFRB| D |
D Console Roaot Name | Class | Distinguished Name :l
E-@s ADSI Edit ] CH=GILEAD-NODEL computer CH=GILEAD-MODE 1, CN=Computers, DC=hit32,DC=arg
E"B_ Domain [QA-BIT32-DC.bit32.ora] | | (] Cu=GILEAD-NODEZ computer CMN=GILEAD-NODEZ, CH=Computers,DC=bit32,DC=0rg
= De=bit3z,De=org () cH=GILEAD-NODES computer CN=GILEAD-NODES, CH=Camputers, DC=hit32,DC=0rg
03 an=guitin [ cn=GILEADL camputer CH=GILEAD1,CN=Computers,DC=hit32, DC=arg
-0 (en=computers [ cn=GILEADZ computer CN=GILEADZ, CH=Computers, DC=it32,DC=org
8 2;':5;:z:sii:::;'::;cip [ cN=GILEADEYSHW camputer CHN=GILEADEYSNW, TN=Computers,DC=hit32, DC=0rg
(23 Sl=Loadsim Users () cH=GILEADEYSNY1 canmpuker CMN=GILEADEWSMNW1, CN=Computers, DC=hit32, DC=org
(3 Ch=LostAndFound [ cn=GUESTZ canmpuker CMN=GLESTZ, CN=Computers, DC=bit32, DC=0rg
1230 ch=Micrascft Exchange 5 [ cn=1mTzs027 canmpuker CHN=IMIT25027, CH=Computers, DC=hit32,DC=0rg
23 eN=NTDS Quotas [ cn=1mT25028 computer CH=IMIT25028, CN=Computers, DC=hit32,DiC=arg
23 cu=Pragram Data ML LorinLL S LUl amputers, ori
23 Ch=sureshog? CAcu=1mITS008 Mave _ 13, Chi=Computers, DC=hit32,DC=org
{2 CH=sureshass (A cu=1mITS035 Mew Connection from Here ke ~p_computers, DC=bit3z, DC=org

{0 Ch=sureshig9s O cn=mrsore New

y [79,CH=Computers, DC=hit3z,DC=0rg

(0 CH=LONGRUN-W2KE
(D ch=LonGRUNZKS

D CN=System
0 Ch=testuser

Mew Window from Here

- 2KE, Ch=Computers, DC=hit 32, DC=org
LNz 8, CH=Computers, DC=hit 32, DC=org

{3 cH=Users [ CH=LONGRUNZKE-H1 Delete
[ CH=LONGRUNZKE-HZ Ferems

(A cn=LonssqLr Refresh

LINZKS-M1, CN=Computers, DC=hit32, DC=org
LINZK8-M2, CN=Computers, DC=hit32, DC=org
DL, CH=Computers, DC=hit32,0C=org

[(Dcn=LonasqLz
(Dcn=LonaTar

DLz, CH=Computers, DC=hit32,DiC=org
T, M=Computers, DC=hit32,DC=0rg

[ CH=MASTERVISTA

Help
([ cy=MIRROR

WISTA, CH=Camputers, DC=hit32, C=arg
CH=Compukers, DC=hit52 DC=org

Figure 25:
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Step 15.You should see the “Properties” screen. Select the “Domain User” and click on “Add”.

N=IMITS-033 Properties 21X

Attribute Editar - Security |

Group or user names:

!ﬁ Account Dperators [BIT 328 cocount Operatars)
Admiirizbr st
m Authenticated Users

ﬁ: Cert Publizhers [BIT 32\Cert Publizhers)

!ﬁ Do ai mits [BIT 3240 omain Admins)
Add... | Remove |
Permizzions for Administrators Allaw Deny
Full Contral -
Fead
Wite

Create All Child Objects
Delete All Child Objects
Allowed to Authenticate

EO0EEEO
OoOoOoooo

||
For special permissions or for advanced settings, Advanced |
click Advanced. —

Ok I Cancel | Apply |

Figure 26:

Step 16.You should see the “Select Users, Computers, or Groups”. Select the domain user name
(InMageUser) created in the previous steps and check if this username is available or not by
clicking on the “Check Names”. Click on “OK”

aelect Users, Computers, or Groups

Select this object type:

IU&ers, Groupz, or Built-in zecurity principals Object Types. ..

From thiz location:
Ibit32.nrg Locations...

Enter the object names to zelect [examples]:
Intd agell zer [Intd agel) ser@ibit32, org) Check Mamez

it

Advanced. . | ak I Cancel |

Figure 27:




Step 17.Click on “Full Control” check box under permission for test and click on “OK”. Repeat the
same process for the DR server.

CN=IMIT5-033 Properties ﬂll
Atribute Edior Secuity |

Group or user names:

€7 EXUSER (EXUSER®bit32 org) ;I
| 5§ inmais\g[inmage@bilﬂ.mg]

ﬂ Intdagellzer [Ink agellsen@hbit32 org)

@ Pre“windows 2000 Compatible Access [BIT 32%Preindows 20... J

@ Print Operators (BIT32%Print Operators)
-yl =

Add... | Bemaove |

Permizzions for Ink agel ser Allow Deny

Full Conral

Fead

“rite

Create &l Child Objects
Delete Al Child Objects
Allowed to Autherticate

For special permissions or for advanced settings, Advanced |
click &dvanced. —
QK. I Cancel | Apply |

oooooa

Figure 28:

‘!.I) Notes:

In Cluster case, you need to add domain user to each node. Repeat the steps from 10 to 13.
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2.3.5 Adding User to Host Machines

Step 18.Logon to “Production Server” with the domain administrator. Open Computer management
console, click “Groups” under “Local Users and Groups”, and click on “Administrators”.

E Computer Management

=) File Action  Wiew  Window

Help

& -

m X R 2E

E Camputer Management (Local)
[=E m System Tools
i| Event Wiewer

Removable Storage
Disk Defragmenter
Disk Management

[+ 35 Services and Applications

T

ackup Operators
istributed COM Users
uests

etformance Log Users
ower Users
rint Operators

emote Desktop Users
eplicatar

4 1S Developers

__wminare__

g Metwork Configuration ...

erformance Monitor U...

Backup Operators can override secu..,
Members are allowed to launch, acti...
Guests have the same access as me...
Members in this group can have som...
Members of this group have remote ...
Members of this group have remote ...
Power Users possess mast administr...
Members can administer domain prin...
Mermbers in this group are granted b...
Supports File replication in & damain

Users are prevented from making ac...
Debugger Users are non administrat. ..

Group for the Help and Support Center

115 Worker Process Group

Members of this group have access t...

Wisual Studio developers can author ...
WMware User Group

Figure 29:

Step 19.You should be able to see administrator’s properties screen and click on “Add”.

Administrators Properties :

General |

Descripbon:

Members:

g Adminishators

2]

Inkagellser (Int agellser@bita2 org)

Figure 30:
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Step 20.You should be able to see “Select Users, Computers, or Groups”, Select the domain user name
(InMageUser) created in the previous steps and check if this username is available or not by
clicking on the “Check Names”. Click on “OK”.

elect Users, Computers, or Groups

Select this abject type:

|Uws_ Groups, of Buitin security prncipals Dbject Types...
Erarn thes location:

|aeidmm:wr.net Locations..
Entes the object names bo select [examples)

Intagellser [InMaquser@bitEZorqi Check Names

admm| [ ok | coancel |
Figure 31:

Step 21.Click “Start->Control Settings->Administrative Tools”. You should be able to see
“Administrator’s Properties” screen. Now, click on “Apply” and then on “OK”.

Administrators Properties 2]
Geneal |

o the computer/domain

Figure 32:
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2.3.6 Adding User to Logon services

Step 22.Click “Start->Program Files->Administrative Tools->Local Security Policy”.

E Brogyams , @ Microsoft Exchange ¥ ,, Terminal Services Configuration

Eﬂ Adrministrative Tools Er' Local Security Policy

Figure 33:

Step 23.You should see “Local Security Settings” screen, select “User Rights Assignment”, and select
“Log on as a Service”.

iii Local Security Settings

File  Action iew Help

e | BE X E R 2

@ Security Setkings Folicy  # I Security Setking
@ Account Policies Access this computer from the net... Evervone,*5-1-5-2..,
=8 Local Policies Act as part of the operating syskem  BIT32Yadministratar, .
{8 Audit Policy ndd warkstations to damain

{8 User Rights Assignment ndjust memory quokas for a process  LOCAL SERVICE,ME...

] Public key Policies
2 Software Restriction Policies

{18 security Options P.Ilow log on locally

P.Ilow log on through Terminal Ser. .,

*5-1-5-21-3958233...
Administrators,Rem. .,

B ck up files and directories

Administrators,Back.
0 on as MNE H
. Change the svstem time LOCAL SERVICE,A...

,g IP Security Policies on Local Computer

Figure 34:

Step 24.You should see “Log on as a Service Properties” screen, click on “Add User or Group”, and
click on “OK”".

Local Securty Setiing | Explain This Setting |

Log on a3 a service

ASPHET
Intdagellser (Intagellser@hitd2.omg)

Add User or Group.... I

Figure 35:
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Step 25.This should open “Select Users, Computers, or Groups” screen, select the domain user name

created in the previous steps and check if this username is available or not by clicking on the

“Check Names”. Click on “OK”.

select Users, Computers, or Groups [ 7] %]

Select this object type:

|Uu|s_ Groups, of Bullt-in security pincipals Dbject Types...
FEra thes lacation:

|:ciol.ucho¢uw.ne: Locations., I
Entes the object names to select [examples)

IntageUser (Int agel) sen@Ehita2. orgl LCheck Names

advanced. | [ o ] Concel |

Figure 36:

Step 26.You should see the previous screen. Now, click on “Apply”, and then on “OK".

.0g on as a service Properties 2 x|

Local Secuity Setting | Explsin This Setiing |

fﬂ Log on a3 a service

ASPMFT
Int agell zer [Ink agell ser(3hit32. ong)

Add Uger or Group... I Hemove

Figure 37:
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Step 27.Log on to “Production Server” with the domain user created above. Click “Start->Run-
>Services.msc”, select the “FX agent service”, right click, and click on the “Properties”.

Services (Local)

InMage DR-Scout FX Agent Mame 7 | Description | status
v Distributed Link Tracking Client  Enables cli...  Started

Stop the service lE uk B Agent Start S d
Restart the service %InMage DR-Scout v Agent ;t@ Ctarted

%Interswte Messaging

Pause:

Descripkion: %IPSEC Services R Started
File Reeplication Service %Kerberos Key Distribution C Resta_rt

%Licensa Lagging -

%Logical Disk Manager Al Tasks » Btarted

%Loglctal Disk Manager Admini Refresh

%Machlne Debug Manager Started

%Mcnfee Framewark Service Properties Skarted
%Massenger o k
%M\cmsoft Exchanne Event e

Step 28.You should be able to see the “FX agent Properties” screen. Enter the “Domain Username”
and password details. Then, click on “Apply” and then “OK”. Restart the FX agent service and
repeat the same process for the DR server.

InMage DR-Scout FX Agent Properties {(Local C e |

General LogOn | Hecovel_l,ll Dependenciesl

Figure 38:

Log ot a3

" Local System account

[T Allovs service to interact with deskiop

&' Thiz account: ||nMaEIBUSBI Browsze.. |

Pazzward: Ioooooooo

LConfirm pagzword: I""""|

Y'ou can enable or dizable this zervice for the hardware profiles listed below:

Hardware Prafile | Service |
Prafile 1 Enabled

Erstle | Disable |

0K I Cancel | Apply |

Figure 39:

"!L() Notes:

In Cluster case, you need to add domain user to each node. Repeat the steps from 1 to 8.
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2.4 Verifying privileges
It is recommended that you check the privileges for failover and failback. This may be performed
through the FX job.

Step 29.Access the CX Ul and click on “File Protection” , Click on “New Job Group Wizard” to
continue

File Protection

Applications Filter:

Application Per Page :!5

Mo Replication Applications To Display

Mew Job Group Wizard

Manage Templates

Figure 40

Step 30.Click on “Add Job”

File Protection

Replication Jobs=

[:E Application Source Target Target Directory

Mame Host Soxbcedlirectory Host
Na Jobs added par

Cancel

&dd Job

Figure 41



Step 31.Select the “Source” as the production file server and the “Destination” as the DR file server.

Select the FX template as “VerifyFileServerPermissions” and click on “Next”

File Protection Wizard: Replication Pair
Replication Hosts
oo
Job Description: |
Source Destination
Host Host
(%  FILESERVER1 [Windows] " FILESERVER1 [Windows]
" FILESERVERZ [Windows] % FILESERVERZ [Windows]
Directory Directory
I I
I “wierify File ServerPemissions ;l
Next -> Cancel |
Figure 42

Step 32.The “Job Options” screen appears, scroll down and click on “Finish” without changing any

settings

Send E-mail alert ifl5 minutes passed withoutjob prograss

Pre execution script pathnamel'missions -app FileSenver -z FILESERWERT 4 FILESERWVERZ

Post erecution script pathname|

Pre execution script pathname (destination)l;ation.exe"-\rerif\,rpennissions -app FileServer -z FILESERWEF

Post execution script pathname (destination);

Catch all job modiﬁerl"SUPer For power users only

<- Back

Cancel

Figure 43
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Step 33.The Job will be set to run “On Demand”, click on “Finish” to save the job

File Protection

Group Schedule
Schedule Type Schedule Time

Cnce At <n Demand

Set Schedule

Replication Jobs

B_. Application Source = Target =
G_ i Host Source Directory Host Target Directory
Rup arder I
CiWProgram Ci\Program
[ Ungrouped  FILESERVERL Filez\InMage FILESERWYERZ  Files\InMage
Systernsifailoveridata Spsternsifailoveridata
Details | Remove Cancel |
add Job
Finish
Figure 44

Step 34.Start the FX job through the File Protection screen and monitor the progress through the
“Protection Status” screen. The result of this task will be found under the FX log.

File Protection Status

Filter Job Description Application
Set
I Select =
Clear
E VerifyFileServer... Ungrouped

Start Time

2009-02-02 00:50:29

Figure 45

You should see the message “[SUCCESS] The logon user has sufficient permissions to perform
failover/failback of the Application” if the FX agents have sufficient privileges or “[ERROR] The
service/logon account does NOT have sufficient privileges to update/modify Service Principal Name
attribute in the Active Directory of the above failed server accounts” if the FX agents do not have
enough privileges
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Part 1: Non-Clustered Environment

This part explains protecting File Server in non-clustered environment where production server and
DR server both are standalone.

34



3 Introduction to Non-clustered Solution

This solution is divided into three major sections: Protect, Discovery, and Recovery. Each of these
sections contains a set of steps.

-
f

*Replicate required volumes with media retention
‘ P rOteCt *File system Consistency tags
L. -
e ™
L D ISCove ry *FX job to replicate registry settings from source to target

o

r:" T,

sFailover and Failback both may be performed through CX Ul
L Recovery and CLI

Figure 46:

Protect: Identify the volumes containing the shares or folders that are to be protected. Replicate the
volumes to the target host with CDP retention enabled. Enabling CDP retention gives you a “roll back
in time” capability. Only Shared folders residing on replicated volumes will be protected and
recovered.

Discovery: A plain VX replication replicates all data on the source volume. Folders which are shared on
the source volume will not be shared on the target volume by mere replication. Since all the “shared”
information will be stored within the system registry. To overcome this, a discovery job is set to restore
shared folders back to their respective shared state on the target volume. This information will be used
during failover or failback.

Recovery: This section is divided into two parts, failover and failback.

Failover: This section explains planned and unplanned failovers both through CX UI and command
line interface.

Failback: A failback is similar to that of a planned failover. Failback is performed in a set of three steps.

!
s Caution:

After setting the replication pair, again run the discovery job as discovery job gather the file
share information specific to the protected volume.
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4 Protect

Identify and replicate the volumes on the Production File Server (source host) to the DR File Server
(Target host).

In the figure below, the “Production File Server” has a volume E: containing four shared folders. The
objective of this solution is to maintain backup of the production volume along with its shareable

properties.

File Edit ‘iew Fawvaoribes Tools  Help
(JBack = | - g | - Search [ Folders | B

Address |<e £

Folders w | Name
(& Deskiop (CeBackup_data |
(L) My Documents ﬁE!'IEIII'IEErlng
=l CJ My Computer EiFinance
ﬁ; 34 Floppy (8:) lEiHuman Resources
<@ Local Disk {C:) =1 N
i CD Drive (D) I Logistics

Figure 47: Source host before failover



4.1 Discovery

You can discover the File Share folder by setting File Server Discovery job.

Step 35.Navigate to “File Protection” on the CX user interface. Then click on “New Job Group -> Add

Job”. Enter the name of the “Application” and the “Job description”.

Step 36.Select the production file server for source and DR file server for destination. Then select the FX

template as “File Server Discovery” and click on “Next”.

File Protection Wizard: Replication Pair

Logged in as ‘admin’ - Logout

Replication Hosts

Application = T =
Mame: IF'ES‘E“'-.'I.}.GFP“-."?’

ID@mver:rg Shared folders

Job Description:
Source Destination
Host Host
{3 | FILESERWER1 [Windows] (O | FILESERVER1 [Windows]
(" | FILESERWERZ [Windows] (% | FILESERWERZ [Windows]
Directory Directory

2 |

I I File Server Discoveny

Next -> | | Cancel |

Figure 48: Setting FX replication

"% Caution:
It is strongly recommended that FX and VX agents is installed in the same folder (FX agent will be

installed under the folder “FileRep” under the VX installation folder)
Discovery is to be executed at least once if an unplanned failover is to be performed at a later stage.

i
“\I’J Notes:
Any changes in file share will require the Discovery job to run again to update the target host

accordingly. By default the Discovery job will run once a day




Step 37.Scroll down to “Miscellaneous Options” to observe the source pre script and target post script

are filled up automatically. Do not change any settings then click on “Finish”

Send E-mail alert i'FIS | minutes passed without job progress

Pre executicn script pathnamel'-ais.mver-appﬁiﬁewer-s FILESERVER1 -t FILESERVER2

Post execution script pathnamEI

Pre execution script pathname I:destinal:ion}l

Post executien script pathname I:destinatiun]l_‘-&smygr-appf:':Earver-s.FIL_E,SEI_:tVEF{! - FILESERVERZ

Catch &ll job mc-r.iiﬁerl__ for power users only

<- Back | | Finish-> | Cancel |

Figure 49:

Step 38.Schedule the job To “Run on Demand”. And click on “Finish” to save the job.

File Protection

Legged in as 'admin’ - Logout

Group Schedule
Schedule Type Schedule Time
Once At On Demand

_Set Schedule |

Replication Jobs

") —_—
[:BT Ap:l;::un Sowrce Host Source Directory Target Host Target Directory

Run order 1

SELE C:\Pragram C:\Pragram
[ 2 FILESERWVER1 | Files\InMage FILESERVERZ | Files\InMage

Discovel

24 Systems'Failover\Data Systems'Failover\Data
Details | | Remove _ Cancel
Add Job |

Finish |

Figure 50: FX job about to be saved.

Step 39.You may start this job through “File Protection” on the CX Ul and monitor its status on the
“Protection Status”. The status of the job shows as “completed” once the job is successful.

File Protection Status

Filter Job Description Application Status Source Host Source Directory Target Host Target Directory e
set || .
_Clear ||| ™
e C:\Program C:\Brogram =
Discovering Shar... 5 Completed FILESERVER1 | Files\InMage FILESERWVERZ | Files\InMage
iscovery 3 \ \ \ Dej
Systems\Failover\Data Systems\Failover\Data

sults 1-1 of L
= > =»

Clear logs for selected jobs | Delete all job history

Figure 51:
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4.2 VX Replication

Step 40. Open the CX user interface, click on “Volume Protection”, select the required volume and

then click on “Start Replication”

Volume Protection: Source Site

Logged in as 'admin’ - Logout

Source | Target

Protected Drives

Server Pri Volume
Primary Drives
[#l Frieservera
[=] Frieserver:
Server Pri Valume
o FILESERWER1 E [ New Veolume )
L3 FILCOCR W ER L T
& FILESERVER1 G
] FILESERWER1 H [ Mew Volume
] FILESERWER1 iz e}
o FILESERWER1 1 Ne

FS
NTFS
NTFS
NTFS
NTFS
NTFS
NTFS

Application
Application Capacity
Unknown 542837
Unknown S4Z83]
Unknown 542833
Unknown 2154355
Unknown 5428323
Unknown 5428317
Start Replication Resef |

Figure 52: Selecting source volume for replicating

Step 41.This will open up the target volume page. Select the exact same drive letter on the target host
and scroll down to set “Replication Options”

Host: FILESERVER1
Drive: E

Capacity: 542835712

Select a target WAN volume

B FILESERVER1

& InMzgePrafiler

WAN Server Volume
= Eneserverz
i |FILESERVERZ [ MNaw WVeolums
T PILEC e T TN VoIUmE
(O  FILESERVERZ G [ New Volume )
{0 | FILESERVERZ H [ Mew Valume ]

Capacity (Bytes)

S428359
S428359
5428354

215438773

81520

Figure 53: Selecting corresponding target volume
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Step 42.Select a desired “Process Server” and scroll down.

Process Server

Select Process Server
Mumber of Pair Configured

IMITS234. INMAGE. IN [(10.0.1.234)
IMITS245, INMAGE.IN (10.0.1.245) 0

Figure 54

Step 43.Check the “CDP retention option”. The rest of the options are optional. Then click on
“Submit”

Replication Options

[T Secure transport from Source to InMageCx
[ | Secure transport from IndMage CX to destination

Sync options: | Fast -

Use cumpmssiun: I C¥ Based I:IZII'I'IIZII'ESSiIZII'I ‘;I
[Ovenides existing 1-M replication pairs)

Add to volume consistency group: I Mew “flume Group _;j
CDP Retention

Enable COP Retention option

Automatic Resync OpHons

Start between hours |13 : !DD and IE : !E“:' after waiting !3['
minutes. (All imes are local to CX)

Subrnit Zancel Reset

Figure 55: Setting Replication Options

!
N Caution:

You will need to enable CDP retention for all VX replication pairs




Step 44.The final screen opens where you could choose the type of retention policy for this replication
pair. Enter the required inputs and then click on “Submit”. This starts the replication pair.

Volume Protection: Retention Options
Logged in as 'admin' - Logout

Pair Details

Server Pri Volume Remaote Server Vaolume

m

m

FILESERVER1 FILESERWERZ

Retention Logging Palicy

Retention Palicy Roll-backward
Retention Log Size 0.00 (MB) Current Retention Log Size o000 {MB)
Unused Space 256.00 (MB)

Retain changes upto I2,EvS | M_EEE (Cannot be less then 256 MB)
Retain changes upto the (time) I [Days) I (hrs.}

On insufficient disk space Pamepe ey v Eention: o

o Pause differentials

Fliogs | (Eg:- K:\log_data)

Log data diractory SED
F.G.H are drives suggested for storing rollback log files.

Configure Threshold for Alerts

Alert when disk space utilization reaches B0 %o

Submit || Cancel |

Figure 56: Defining retention policy

Step 45.This starts the replication pair, repeat the same process for the other volume(s) that are to be
replicated.

Step 46.Click on the “Protection Status”, this will show the status of the replication pairs. The status
changes from “Resync Step1” to “Resync Step2” and then finally reaches “Differential Sync”.

Protection Status
Logged in as ‘admin’ - Logout Server Time: Jun-19-2008 07:34:17

Volume Protection Status

Resyncs In | o - .
4 Resync In Transit | Differentials Left Resync | View
Server Volume Group Tran‘s'\.‘t BS)tepl Step? (HB) (MB) Resync progress RPO Status Required | Details

1-
FILESERVER1- >FILESERVERZ E'p"°d“E”‘°”i > Velume E 0 0 0 N/A 0 minutes Differential Sync NO

Figure 57: Monitoring replication pair(s) status
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4.3 Consistency

Once the Discovery job is complete, proceed to setup a consistency job. This FX job will issue
consistency tags on the source volume(s) at regular intervals. A rollback requires at least one
consistency tag on the target volume.

Step 47.Click on “File Protection -> New job Group Wizard -> Add Job”. Enter the “Application

Name”, “Job Description” then select the production server as “source”, DR server as
“Destination” and select the FX template as “File Server Consistency” then click on “Next”

File Protection Wizard: Replication Pair
Logoed in as ‘admin’ - Logout
Replication Hosts
Application -
i |Fie Server Consistency
Job Description: I{:ors.shercy
Source Destination
Host Host
(%  FILESERVER1 [Windows] " | FILESERVERL [Windows]
| FILESERVERZ [Windows] {3 | FILESERWERZ [Windows]
Directory Directory
I | FieServer Consistency = I
Next -= Cancel |
Figure 58

Step 48.The FX job Options page opens up, all the required fields are filled up automatically. Scroll
down to observe the source pre script taken automatically. Do not change any settings, click on

“Finish”
T T
Send RPO alert ifll:' minutes passed
Send E-mail alert i1"|5 minutes passed withoutjob progress

Pre execution script pathnamehslﬂpplicminn.exe" -applyTag -app File Server -5 FILESERWE

Post edecution script pathnamel

Pre erecution script pathname (destinatinnjl

Post execution script pathname (destinationjl

Catch all job modiﬁerl“S'-lF'EF For power users only

Finish - = Cancel

Figure 59:
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Step 49.Click on “Set Schedule” to change the job execution frequency and then click on “Finish”

File Protection

Logged in as 'admin’ - Logout

_ Set Schedule .

Replication Jobs

@ Application
(&

Source Host Source Directory

Group Schedule
Schedule Type Schedule Time
Run Every 10 Minutes

Name Target Host Target Directory
Run order 1

C:\Pragram C:\Pragram

File Server B Files\InMage Files\InMage

o Censistency RIEESERLE Systems'Application FUEREEE Systems\Application

Data Data

_Details | _Remove | _Cancel |
Add Job ||
Finish ||

Figure 60:

Step 50. The job can be started manually if required through “File Protection”.

File Protection

Logged in as ‘admin’ - Logout

Applications

E.l File Server Consistency

Job Description

& consistency...

Results 1-1o0f1 =< <1 > >>

Status Source Host

Running FILESERVER 1

_Stop |

Source Directory Target Host Target Di
C:\Program C:A\P
Files\InMage ’ Files!
Systems\Application it = Systems)
Data Oy

Start | Details | _Remove |

Filter:

Application Per Page:l.‘i__ |

Figure 61:
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5 Recovery

5.1 Failover

A failover is performed when there is an outage on the production site. If the outage is expected, such
as a mock drill or to test the backup environment, then a planned failover is performed. A planned
failover is performed either through CX Ul or through CLL

If the outages are unexpected, then an unplanned failover is performed. If the CX server is available

then an unplanned failover is performed through the CX UL If the CX server is down along with the
production server then an unplanned failover is performed through the CLI.

_ Unplanned failover Planned failover

When to use Real-time outages or Mock drills, To test the setup.
unexpected outages Any expected outages

Recovered to To latest consistent tag Issues a consistency tag on the
common for all replication  protected volumes. Target is
pairs recovered to the same consistent

tag.

Performed through CX Ul Yes, unless the CX is down.  Yes

Performed through CLI Yes Yes

5.2 Prerequisites for failover or failback

e  Check the FX agent service privileges on the production and DR file servers.

e  When FX is up with local system privileges, ensure that you store domain information through
winop.exe on both the production and DR file servers.

e When the FX agent is up and running with local system privileges, you will need to edit the FX
job’s pre script and post script for failover or failback with the “—useuseraccount” switch.

¢  When the FX agent is up and running with domain administrator privileges, there is no need to
edit the FX failover or failback job settings

e Ensure that target volume drive letter or mountpoint is same as that of source drive letter or
mountpoint when setting replication pair.

e Disable “Register this connection's addresses in DNS" check box located on DNS tab of each
network interface’s TCP/IP advanced properties. If it is set, after failover if Source machine is
restarted then, it will re-register it's IP at DNS server.
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.
L\ll) Notes:

File server failover does not support web sharing

To restore folder icons after a failover, the respective icons need to be replicated to the path on
DR file server that is identical to the path on production file server

Cluster File server failover is supported only for single network name. Failover of file shares
having multiple network name dependencies is not supported.

For Windows Vista and Windows Server 2008, if MS Shadow copy provider is not properly
installed, VACP will hang as VSS will take time to send the response to VACP. When VACP
fails, look at the Application event log for more information

If source has more than 1 NIC, then either uncheck "Register this connection's addresses in
DNS" check box for all NICs OR add the "DisableDynamicUpdate" of type DWORD to the
following registry key with value set to 1
"HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\ Tcpip\Parameters" This
key disables DNS update registration for all adaptors on that computer.
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5.3 Planned Failover through CX Ul

Step 51.To perform a planned failover through CX Ul, setup an FX job with source as the production
file server and destination as the DR file server, Select the FX template as “FileServer Planned

Failover”, then click on “Next” to proceed.

File Protection Wizard: Replication Pair

Logged in as 'admin' - Logout

Replication Hosts

::r':‘“::a = IF e Server
Job Description: IParr—'_k: Failover
Source Destination
Host Host

(& | FILESERVER! [Windows] {0 | FILESERVER1 [Windows]

{ | FILESERVERZ [Windows] {%) | FILESERVERZ [Windows]

Directory Directory

FilzServer Planned Failover j

Next -= Cancel

Figure 62:

Step 52.The FX job options screen opens up with all the required fields filled up, scroll down to observe
that the source prescript and target post script are already filled up. Do not change any settings,

click on “Finish”

Send E-mail alert iF|5 minutes passed without job progress

Pre exscution script pathn meban.'ar-s FILESERVERT -t FILESERVER2 -busift|n -t2g NONE]

Post execution script pal:hnarnel

Pre execution script pathname ::destination}l

Post execution script pathname [desting ion]lar-s FILESERVER1 -t FILESERVER2 -builtIn -t=g FLANNELD

Catch All job modiﬁerl—s..par for power users anly

<- Back Finish -= Cancel

Figure 63:

!
% Caution:
When FX service is running with local System account, ensure to edit the source pre script and

target post script with the additional “—useuseraccount” switch.
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Step 53.The next screen appears, the job is set to execute “On Demand” by default. Click on “Finish”
to save the job.

File Protection

Logged in as 'admin’ - Logout

Group Schedule
Schedule Type Schadule Time
Once At On Demand

Set Schedule

Replication Jobs

[:E Application
i H

ame Source Host Source Directory Target Host Target Directory

FRun order 1

C:\Program C:\Program
(o] File Server | FILESERVER1 | Files\InMage FILESERWERZ | Files\InMage
Systems\failoveridata Systems'failoveridata

Details || Remaove || Cancel ||

Add Job
Finish

Figure 64:

Step 54.To perform a planned failover, click on “File Protection” and start the corresponding job

File Protection

Logged in as 'admin’ - Logout

‘Applications
Application Per PaqE:E
= Fite server
Job Description Status Source Host | Source Directory Target Host | Targq
C:\Pragram
o] planned failover... Starting... FILESERVER1 Files\InMage FILESERVER2 i
Systems\fziloveridata Syst:

Results1-10f 1 << <1 > >

Stop ‘l Start ” Details ‘l Remove ||

Figure 65:

‘!'n) Notes:

After failover

VX Replication pairs are no longer active

Shares will be active on the target as well.

Discovery and Consistency jobs will be set to “On demand”




5.4 Planned failover through CLI

Step 55.A planned failover can also be performed through the CLL This requires the CX server and the
production server to be up and running. Access the production machine’s command interface as
domain administrator to issue the following command under the VX installation folder

Application —failover —planned —app fileserver —s <production file server name> -t <
DR file server name> -builtin —tag NONE

C=“Program Files“InMage Systems>Application.exe —failover —planned —app FileServer —s FILE
SERVER1 —t FILESERVER2 -builtin —tag NONE

Command Line: Application.exe —failover —planned —app FileServer —s FILESERVER1L -t FILESER
UER2 -builtin -tag NONE

Running wnder the user: bhitd2.org~Administrator

Local Machine Name is @ FileServerl

Process [D: 3812

FILESERUERL IP addm 1A8.@.161 .15
FILESERVER2 IP address 18.8.1681.16

Uerifying DNS Permissions...

[ FILESERUER1 1 Passed.

Uerifying SPM Permissions...

[ FILESERUER1 1 Passed.
[ FILESERUERZ 1 Passed.

[SUCCESS 1The logon user has sufficient permissions to perform failover-sfailback of the fApp
lication.

IT E:NIT

Engineering E:s\Engineering
Finance E:~Finance

Human Resources E:“Human Resources

Figure 66:

Step 56.At the end of the output a command is displayed within “important information” as shown in
the picture below. This command is to be executed on the DR File server to complete planned
failover.

IMPORTANT INFORMATION
Please run the following command on the Target Host to complete failover

Application.exe —failover —planned —app FileServer —s fileserverl —t fileserverZ —huiltln
—tag FileSystemd4%alelc4d

sesxSuccessfully finished failover at soupceIeeess

C:sProgram Files“InMage Systems>

Figure 67:

Step 57.Ensure that you copy the “<VX installation folder>/failover/data” folder from production file
server to DR file server’s same location. This folder contains a list of five files as shown below

e <Production file server name>_<DR file server name>.txt

e <Production File server name>_FileServer_FILESERVER2.reg

e FailoverServices.conf

e consistency_tag.txt

e <Production File server name>_fileserver_config.dat
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Step 58.Access the DR file server’s command prompt then navigate to the VX installation folder to
execute the above command.

WINDOWS  system32\ cmd.exe

GC:sProgram FilessInMage Systems>*Application.exe —failover -planned —-app FileServer —s file
serverld -t fileserver2 -builtln —tag FileSystemd%aleicd

Command Line: Application.exe —failover —planned —app FileServer —s fileserverl —t fileser
ver2 —bhuiltln —tag FileSystemd4%alelcd

RBunning under the user: BIT32_ORGradministrator

Local Machine Mame is : FileSerwver2

Process ID: 1488

fileserverl IP address = 18.8.161.15
fileserver2 IP address = 10.8.101.16

Verifying DNE Permissions...

[ fileserverl 1

Verifying PN Permissions...

[ fileserverl 1 Passed.
[ fileserver2 1 Passed.

{SUCCESS]Ihe logon user has sufficient permissions to perform failover-failback of the App
ication.

Getting target protected Volumes from CH
s SourcesTarget Drive Pair Output From CH: E=E,

s Fpund following replication pairs from Source Host : fileserwerl to Target Host @ fi
leserver2
Pair : E=E
source volume: E
target volume: E

Uolume MountPoint Retention log path

F:/loy_f/B723098863/5DDC3299-5281-A743-A72CA5D@6 CD)

E
6894FE/cdpvl .db

Persisting the retention log configuration of the discovered volumes: fileserver2
Opened LANMANSERUER'= SHARE HKeys successFully.

Opened LANMANSERVER’s Security Keys successFully.

Hax attemptsz=18

Target will attempt at most 18 times of each 38 seconds for the arrival of the consistency
tag from the source server

Figure 68:

"!f) Notes:

When there are more than one domain controller in the domain you may want to perform AD
replication to update the other domain controller with the SPN and DNS entries in the AD/DNS Server

By default AD will not be replicated during File server failover. However if you need AD replication as
part of File Server failover edit the command line/pre and post script with the “—~doadreplication”
switch.

OR

You may run “WinOp.exe” from command line to perform AD replication and DNS Update
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5.5 Unplanned failover through Ul

Step 59.Unplanned failover through the CX Ul is preferred when the production File Server is down

but the CX server is up and running.
Step 60.Unplanned failover can be performed through the FX job. Setup the FX job with source and

destination as the DR file server then select the FX template as “File Server Unplanned Failover”,

click on “Next” to continue.

File Protection Wizard: Replication Pair
Logged in as 'admin’ - Logout
Replication Hosts
Application IF ——
Name:
Job Description: IU':--E”E: Failover
Source Destination
Host Host
{0 | FILESERWERT [Windows] {0 | FILESERWER1 [Windows]
{% | FILESERWERZ [Windows] {% | FILESERWERZ [Windows]
Directory Directory
I |
I I FileServer Unplznnad Failover j I
Next -> Cancel
Figure 69:

Step 61.The job options page opens up with all the required fields filled up including the target post
script. Change the “—s” switch to the production server name

"C:\Program Files\InMage Systemsl\Application.exe" -failover -unplanned -app

FileServer -s <production server name> -t <DR server name> -builtln -tag
LATEST

Step 62.Click on “Finish” to continue.

T T ™

Pre execution script pathnamel

Paost execution script pathnamsl

Pre execution script pathname [destinatig |
Post execution script pathname ::csstinﬁn" rver = FILESERVER 1 -t FILESERVERZ-builtln -tag LATEST -
Catch All job mcciﬂsrl—s.:e‘ for power users only

<- Back Finish -= Cancel

Figure 70:
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!
d Caution:

When EX service is running with local System account, ensure to append the additional
“—useuseraccount” switch to the target post script.

Step 63.The job is set to execute “On Demand”, click on “Finish” to save the job.

File Protection

Logged in as 'admin’' - Logout

Group Schedule
Schedule Type Schedule Time
Once At On Demand

Set Schedule

Replication Jobs

[:g Application

Name Source Host Sowrce Directory Target Host Target Directory

Run erder 1

C:\Program C:\Program
O File Server | FILESERWERZ | Files\InMage FILESERWERZ | Files\InMag=

Systems\failoveridata Systems'\failoveridata

Details Remove Cancel
Add Job
Finish

Figure 71:

Step 64.Click on “File Protection”, then select the job and click on Start to perform an unplanned
failover



5.6 Unplanned failover through CLI

Unplanned failover is performed when both the production server and CX servers are down. To
perform an unplanned failover through command prompt, access the DR File server’s command
prompt then navigate to the VX installation path to issue the following command

Application.exe —failover —unplanned —app fileserver —s <production file server> -t

<DR file server> -builtin -tag latest

C:“Program Files“InMage Systems>Application.exe —failover —unplanned —-app FileServer —sz FI
LESERVER1 —t FILESERUER? -builtin —tag latest

Command Line: Application.exe —failover —unplanned —app FileServer —s FILESERUER1 -t FILES
ERUER2 -builtin —tag latest

Running wnder the user: bit32.org“Administrator

Local Machine Mame iz : FileServerl

Process ID: 3628

FILESERUERL IP address
FILESERUERZ IP address

18.8.181 .15
18.8.181.16

Verif ying DNS Permissions...
[ FILESERUVER1L 1

Verif ying SPN Permissions...

[ FILESERVERL 1 Passed.
[ FILESERUERZ 1 Passed.

[SUCCESE 1IThe logon user has sufficient permissions to perform failoversfailback of the App
lication.

Shared Resource Name Local Path

1T E:sIT

Engineering E:“\Engineering
Finance E:~Finance

Human Resources E:“Human Rezources

Exported Registry file successfully.

Following Entires will bhe removed from exported registry file.
Vo lumeMountPoint Name

c filezerver
G:~MOUNT1 share_3

G:“MOUNT1 f—tgt

G:sMOUNT1 FileSharel-target
G:“MOUNT1 hjhjkhj

Successfully Modified the Exported File

Figure 72:

<" Caution:

When FX job is running with local System account, ensure to append the additional
“—useuseraccount” switch to the end of the command.
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5.7 Failback

A failback is performed when the production server recovers from the outage. The process is similar to
that of a planned failover.

[ Prepare J

Figure 73:

-

Reverse ] { Planned -

Discovery J { Replication Failback

5.7.1 Prepare

When the FX agent service is configured to run at the domain user it will not start after failover due to
explained SPN changes. If the production machine is restarted after failover the user cannot logon to
the domain. To overcome this issue run the following command from DR server to add the host SPN
entries back to the production server.

WinOp.exe SPN -addhost <production server name>

Logon to production server and run the FX agent service. Now proceed with setting the FX job.

‘!L) Notes:

This preparation is not applicable when FX agent is already configured with local
system privileges.
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5.7.2 Discovery

A discovery job is executed to maintain shared folder information specific to the replication pair. A
reverse discovery is performed here to replicate all the shared folder information from DR file server to
Production file server.

Step 65.0pen the CX U], click on “File Protection” to setup the Discovery job.

Step 66.Select the “Source” and “Destination” as DR File server and Production File server
respectively. Select the FX template as “FileServer Discovery” then click on “Next” to continue.

File Protection Wizard: Replication Pair

Logged in as 'admin’ - Logout

Replication Hosts

Application
Name:

Job Description:

Source Destination
Host Host
| FILESERWER1 [Windows] (s | FILESERWER1 [Windows]
(8 | FILESERWERZ [Windows] | FILESERWERZ [Windows]
Directory Directory
| ]
FileBerver Discovery j
Next -= Cancel

Figure 74:

Step 67.The job options page opens up with all the required fields filled up, scroll down to observe the
source pre script and target post script is taken automatically. Do not change any settings, click on
“Finish”

Send E-mail alert if |3 aiez paccad withoutioh progre

Pre execution script path I'I1§|-: iscover -app FileServer-s FILESERVERZ -t FILESERVER1

Post execution script pathnarnsl

]

= ewecution script pathname [desti

Post execution script pathname | = FILESERVERZ -t FILESERVER1

Catch &Il job mc:iﬁerl—s.:e' for power users only

<- Back Finish -= Cancel

Figure 75:
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Step 68. The next screen appears, click on “Set Schedule” to change the execution frequency. Click on

Finish” to save the job

File Protection
Logged in as 'admin’ - Logout

Group Schedule
Schedule Type

Every Day At

Replication Jobs

Source Host
Name

[:ﬂ_ Application
=
Run order 1

o File Server

Details ||

Source Directory

Schedule Time

06:00

Set Schedule

C:\Program
FILESERWERZ  Files\InMagse
Systems'failoveridata

Remove ||

Target Host

FILESERWER1

Cancel ||

Add Job

Finish |

Target Directory

C:\Program
Files'InMage
Systems'fzilover'data

Figure 76:

Step 69.Then start the discovery job, through “File Protection”

File Protection
Logged in as 'admin’ - Logout

Applications

B File Server

Job Description

(o] discovering shared folders...

Results 1-10f1 << <1 > ==

Displaying 1 to 1 (of 1 Applications)

Status

Starting..

Filte

Application Per Page:

Source Host Source Directory Target Host Target Di
C:\Program C:\P

FILESERWERZ2 Filzs\InMags FILESERVER1 Files!|
Systems\failover\data Systems|

Stop || Start || Details || Remove ||

Figure 77

‘!'I) Notes:

Issuing consistency tags after discovery is optional while failback because consistency tag
will be issued internally by the planned failover script to minimize data loss




5.7.3 Reverse replication
A reverse replication is performed to update the production file server with all the data changes

occurred during the outage.

Step 70.Access the CX Ul, click on “Volume Protection” then expand the DR file server to select the
source volume (the same volume was used as a target earlier) and click on “Start Replication”

Volume Protection: Source Site

Logged in as 'admin’ - Logout

Source | Target

Protected Drives

Server Pri Volume F5 Application

Primary Drives
FILESERVER1
[=] F1Leserver2

Server Pri Volume Fs Application Capacity (Bytes)
= FILESERVERZ E [ Production ) NTFS cngwn 542835712
TIIES e e 7 NTFS

T 5428335712
o FILESERVER2
o

542835712
FILESERVER2 win 21543587520

NTFS
NTFS

T o

Start Replication Reset

Figure 78:

Step 71.The target screen opens up, expand the production file server to select the target volume
(production volume) and scroll down to set the replication options.

Host: FILESERVER2
Drive: E

Capacity: 542835712

Select a target WAN volume

WAN Server Volume Capacity (Bytes)

= Freeserver:

I {% | FILESERVER1 [ Production } I 542835712
(o FILESERVER1 F [ NewVelume ]} 542835712
o FILESERVER1 G [ NewVelume ) 542835712

Figure 79:



Step 72.Select the desired “Process Server” and scroll down

Process Server

Select Process Server
Number of Pair Configured

IMITS234.INMAGE.IN (10.0.1.234)
IMITS245,INMAGE.IN (10.0.1.245) 0

Figure 80

Step 73.Ensure that the “CDP retention” is enabled. Click on “Submit” to continue.

Replication OpHons
|_ Secure transport from Source to InMageCX

[T | Secure transport from InMage CX to destination

Sync options: | Fast -

Use compression: I C¥ Based Compression ;I
(Ovenides existing 1-M replication pairs)

Add to volume consistency group: | Hew wblume Group - I

COP Retenton

Enable COP Retention option

Autematic Resync OpbHons

- | start betwreen hours |1E : ll:“:' and IB : lf“:' after waiting !3['
minutes. (All imes are local to CX)

Subrait Cancel Reset

Figure 81:




Step 74.The next screen opens up, define the type of retention policy and click on “Submit” to start the

replication pair.

Logged in as 'admin’ - Logout

Pair Details
Server

FILESERWERZ

Retention Logging Policy
Retention Policy
Retention Log Size

Unused Space

Retain changes upto

Retain changes upto the (time)

On insufficient disk space

Log data directory

Configure Threshold for Alerts

Volume Protection: Retention Options

Pri Volume Remote Server

E FILESERWER1

Roll-backward
0,00 (MB) Current Retention Log Size

256.00 (MB)

|255 I ME 'I {Cannot be less then 256 MB)
I {Days) I {hrs.)

@ Purge older retention logs

G Pause differentials

{Eg:- K:\log_data)

Volume

E

0.00 (MB)

F.G,H,I are drives suggested for storing rollback log files.

Alert when disk space utilization reaches

Submit Cancel

Figure 82:

Step 75.0nce the replication pair reaches “Differential Sync” proceed to the next step

Protection Status

Logged in as "admin’ - Logout

Volume Protection Status

Server Volume

FILESERVER2->*FILESERVER1

£( Production ] -

=

Resyncs In - ’
Resync In Transit | Differentials Left
Group Transit Stepl Sten2 (MB) M)
(MB)
Valume E o o

Resync progress

0.02 minutes

Server Time: Jun-10-2008 22:50:00

Status

Differential Sync

Resync

Required | Details

NO

View

Figure 83:
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5.7.4 Failback

Step 76.After the Discovery job is complete, proceed to perform a failback. Open the CX UI and setup
the FX job with source and destination as DR file server and Production File server respectively.
Select the FX template as “File Server Planned Failover” and click on “Next” to proceed

File Protection Wizard: Replication Pair
Logged in as "admin’ - Logout
Replication Hosts
:pplication IFiIeser\rer
lame
Job Description: |Failback
Source Destination
Host Host
" FILESERWERL [Windows] (*  FILESERWER1 [Windaws]
% | FILSERVERZ [Windows] | FILSERVERZ [Windows]
Directory Directory
I |
I File Server Planned Failback ;I
Mext -= Cancel
Figure 84:

Step 77.In The “Job Options” Ul, uncheck the “update only (do not overwrite files)” under
“Inclusion/Exclusion Options”.

Inclusion/Exclusion Dptons

Update anly (Do not overwrite newer files)

Only update files that already axist at the destination
Ignore files that already exist at the destination
Ignore files with same size and timestamp at destination

Ignore files with zame size

OO0 00010

Exclude files matching pattern: Separated by ;
|:| Include subset of exclude list matching pattern: Separated by ;
Figure 85
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Step 78.Leave other default selections as it is and scroll down to click “Finish”.

end RFOalert ITl‘-I minutez passed

Send E-mail alert i'F|5 minutes passed withoutjob progress

Pre execution script pathnamelﬂpplicaﬁon.exe" -failback -planned -app FileServer -z FILSER

Paost edecution script pathnamel

Pre execution script pathname (destination]l

Paost execution script pathname (destination]}miﬂn.exe" -failback -planned -app FileServer -5 FILSERWERZ

Catch alljob modiﬁerl“SUPF-'r for power users arly

<- Back Finish -= Cancel

Figure 86:

A
“" Caution:

Although the source pre script and target post script have changed for the failback, the older
commands involving “~failover” and “—ip” switches work as well.

When EX job is running with local System account, ensure to append the additional
“—useuseraccount” switch.

Step 79.The next screen appears, click on “Finish” to save the job. By default the job is set to execute
“On Demand”. Start the job to perform a failback (planned failover).

File Protection
Logged in as 'admin’ - Logout

Group Schedule
Schedule Type Schedule Time
Once At On Demand

Set Schedule

Replication Jobs

Source Host Source Directory Target Host Target Directory

[:g Application

Name

Run order 1

C:'\Program
[ File Server | FILESERWERZ | Filzs\InMags FILESERWER 1
Systemsifailoveridata

Details Remove Cancel

Add Job

Finish

C:'Program
Files\InMags
Systemsifailoveridata

Figure 87:
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6 Failover and failback using crash consistency tag

In normal setup, DR scout uses VSS snapshot to issue application or consistency tag but in a setup it is
not possible to issue VSS consistency tag. In this case, crash consistency tag can be used and the same
can be used for failover and failback. When crash consistency tag is used it always generates
USERDEFINED tag. It will not generate any filesystem or application consistency tag.

6.1 Discovery

Use the application discovery template as used in planned failover. No changes are required.

6.2 Consistency

To set crash consistency FX job use the Fileserver_consistency_fstag.bat file and pass the required
argument as given below.

Syntax:

Fileserver_consistency fstag.bat "List of volumes separated by semicolon” -
CrashConsistency

For example, following volumes G, H, K:\Mntl, J:\Mnt2 have shared folders. Use the following
command in prescript to set the crashconsistency job or run it through CLIL

"C:\Program Files (x86)\InMage Systems\consistency\ Fileserver
_consistency_fstag.bat” "G:;H:;K:\Mntl;J:\Mnt2" —CrashConsistency

"!Lr'} Notes:

List of volumes must be in double quotes else only first Drive or mount point is taken for
issuing tag.

-Crashconsistency can be written with or without double quotes

!
"% Caution:

While protecting large number of databases, application consistency tags may fail. You can use the
file system tag to overcome this error.

Additionally you can also write a batch script and automate this through the FX job.
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6.3 Planned Failover

6.3.1 Planned failover through CX Ul

When you set the planned failover job, in the planned failover template, add the prescript with “-
crashconsistency” and postscript with-“-tagtype USERDEFINED”
For example,

Pre script: "C:\Program Files (x86)\InMage Systems\application.exe" -failover -planned -app
Fileserver -s W2K3-SRC -t W2K3-TGT -builtln -tag NONE -CrashConsistency

Post script: "C:\Program Files (x86)\InMage Systems\ application.exe" -failover -planned -app
Fileserver -s W2K3-SRC -t W2K3-TGT -builtln -tag PLANNED -tagtype USERDEFINED

6.3.2 Planned Failover through CLI

When you run through CLI follow the same procedure as in section 8.2.
The only change is add “—crashconsistency” switch to the source command and target command with
“-tagtype USERDEFINED".

Source Command:
"C:\Program Files (x86) \InMage Systems\ application.exe" -failover -planned -app Fileserver -s W2K3-
SRC -t W2K3-TGT -builtIn -tag NONE -CrashConsistency

Target command:

"C:\Program Files (x86)\InMage Systems\ application.exe" -failover -planned -app Fileserver -s W2K3-
SRC -t W2K3-TGT -builtln -tag <User Defined Tag> -tagtype USERDEFINED
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6.4 Failback

6.4.1 Failback through CX

Use the same failback template as in section 8.2.4. The only change is add ”"—crashconsistency” switch
to the source command and target command with “-tagtype USERDEFINED”.

For example,
Pre script: "C:\Program Files (x86)\InMage Systems\ application.exe" -failback -planned -app
Fileserver -s W2K3-TGT t W2K3-SRC -builtln -tag NONE -CrashConsistency

Post script: "C:\Program Files (x86)\InMage Systems\ application.exe" - failback -planned -app
Fileserver -s W2K3-TGT -t W2K3-SRC -builtln -tag PLANNED -tagtype USERDEFINED

6.4.2 Failback through CLI

When you run through CLI follow the same procedure as in section 8.2.4.
The only change is add “—crashconsistency” switch to the source command and target command with
“-tagtype USERDEFINED".

Source command:
"C:\Program Files (x86) \InMage Systems\ application.exe" - failback -planned -app Fileserver -s W2K3-
TGT -t W2K3-SRC -builtIn -tag NONE -CrashConsistency

Target command:

"C:\Program Files (x86)\InMage Systems\ application.exe" - failback -planned -app Fileserver -s W2K3-
TGT -t W2K3-SRC -builtIn -tag <User Defined Tag> -tagtype USERDEFINED

6.5 Unplanned Failover

When you set the unplanned failover job, in the unplanned failover template, add the postscript with-“-
tagtype USERDEFINED”. The same can be used for the CLI

For example,
“C:\Program Files (x86)\InMage Systems>application.exe -failover -unplanned -app Fileserver -s
W2K3-SRC -t W2K3-TGT -builtln -tag LATEST -tagtype USERDEFINED”
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Part 2: Clustered Production Server
and Standalone DR Server

This part explains protecting File Server in a environment where production server is a cluster and DR

server is standalone.
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7 Introduction to Clustered solution

This solution is divided into three major sections: Protect, discover, failover and failback. Each of these
sections contains a set of steps.

o *FX job to replicate registry settings from source to
Discovery e

*Replicate required clustered volumes with media

Prote Ct retention

*File system Consistency tags

LN o
Fa | | over sFailover can be performed through CX Ul and CLI
N v
Fa | | b acC k *Failback can be performed through CX Ul and CLI
"
Figure 88:

Discovery: A plain VX replication replicates all data on the clustered source volume. Folders which are
shared on the source volume will not be shared on the target volume after roll back. Since all the
“shared” information will be stored within the system registry. To overcome this, a discovery job
replicates all shared information (registry file) from the source host to the target host.

Protect: Replicate desired volumes on a clustered file server to a standalone target host with CDP
retention enabled. Only Shared folders residing on replicated volumes will be protected and recovered.

Failover: This section explains planned and unplanned failovers both through CX Ul and command
line interface.

Failback: A failback is similar to that of a planned failover. Failback is performed in a set of three steps.

\l/ Caution:

After setting the replication pair, again run the discovery job as discovery job gather the file
share information specific to the protected volume.
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8 Protect

Refer to the Prerequisites section on page 11

8.1 Discovery

A discovery job is executed to discover file share volume available on the production server. Discovery

can be performed through CX Ul and CLL

Through CX Ul

Step 80.Login to the CX U], click on “File Protection -> New Job Group Wizard”

File Protection

Logged in as 'admin' - Logout

Applications

No Replication Applications To Display

Application P

New Job Group Wizard |

Manage Templates |

Figure 89:

Step 81.The next screen opens up, click on “Add Job” to continue.

File Protection

Logged in as 'admin’ - Logout

Replication Jobs

[:g: Ap?ililcr:ziun 5;:::;& Source Directory T:Li:t Target Directory
Mo jobs added yer
Cancel
Add Job ||
Figure 90:
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Step 82.Select the active node as the “Source” and the standalone target host as “Destination”. Select
the FX template as “FileServer Discovery” and click on “Next”

Logged in as 'admin’ - Logout

Replication Hosts

File Protection Wizard: Replication Pair

Mext -> |

::rpnlél::atiun I._.,=l=e:F =5erva
Job Description: ID‘E_DF-\.'E!';'

Source Destination

Host Host

(% | 2ZND [Windows] {7 | 2ND [Windows]
{3 | 15T [windows] 3 | 15T [windows]
{7 | DRFILESERVER [Windows] (¥ | DRFILESERVER [Windows]

Diractory Directory

I I
I FiieServer Disoovery. ll
Caneel |

Figure 91:

Step 83.The FX job Options screen opens up with all the required fields filled up. Scroll down to

“Miscellaneous Options” to append the switch — virtualserver <name of the virtual server>
to the source Pre script. Then click on “Finish”

Send E-mail zlert iFIE'

Sznd RPC zlart HIE minutes passed

- L

Pre exzcution script pathn mEIEar'.'E:-E 2ND-t DRFILESERVER -wintusiserver LOGISTICS!

pel

Post execution script pathname [desting

ozt execution script pathnamel_

Pre execution script pathnams :::estinaticn'il

ion I C\Program Fies\InMage Systems 1 Application exe” -discow

Catch &ll job rnc:iﬁerl—:‘_.l:&-’

for pewer Lsers only

<- Back | Finish -= |

Cancel |

Figure 92:
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Step 84.The job is set to execute “On Demand”, you may change this by clicking on “Set Schedule”
button. Click on “Finish” to save the job.

File Protection

Logged in as 'admin' - Logout

Group Schedule
Schedule Type Schedule Time
Cince Ak On Demand

Set Schedule |

Replication Jobs

[:D_ Application | Source
"]

Mol Hoot Source Directory Target Host Target Directory
Rurm arder 1
C:\Program C:'\Program
Clustered e : S
{5 o ZND | FilesiInMage DRFILESERVER | Files\InMage

Systems\failoveridata Systzms1\failoveridata

Details ||| Remowe | Cancel |

Figure 93:

Step 85.Click on “File Protection” then select the Discovery job and click on “Start”

File Protection

Logged in as 'admin’ - Logout

Applications Filter:
Application Per Page:lr
2 clusterad Filesarver
Job Description Status a:;;“ Source Directory Target Host Target Direc|
C:\Program C\Bro
o discovery... Starting... 2ND FilesiInMage DRFILESERVER Files\T

Systems'\fziloveridata Systams 1\f3
Results 1-10f 1 << <1 > =5

_Stop | Start | _Details | _Remove |

Displaying 1 to 1 (of 1 Applications)

_ New Job Group Wizard ||

_Manage Templates |

Figure 94:

You may monitor the job’s progress through the “Protection Status” screen
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Through CLI

Discovery can also be performed through command prompt.
Step 86.Switch to the active node’s command prompt and navigate to the VX agent installation path to
issue the following command

Application —discover —s <name of the source host> -t <name of the target
host> -app fileserver —virtualserver <name of the virtual server>

C:\Program Files-InMage Systems>Application —discover —s 2nd -t drfileserver —app fileserver —-wvirtual
1server logistics

Command Line: fApplication —discou d —t drfileserver —app fileserver -virtualserver logistics

er —s 2n
Running under the user: APP.DEVXSRU.NET“Administrator
Process ID: 3368

Shared Resource Mame Local Path Volume/MountPt Mame

Quest_res Quest M
Accounting_Res M:“Accounting ]

Exported Registry file successfully.

Following En will be removed from exported registry file.
U
1
MNew Folder
Human Resources
Successfully Modified the Exported File
Persisting the information of Shared resources @ 2nd

C:“Program Files~InMage Systems)>_

Figure 95:

Step 87.Then copy the folder “<VX install path>\Failover\Data” folder to the same location on the
target host. Switch to the target command prompt to issue the following command

Application —discover —s <name of the active node> —t <name of the target host> —app
fileserver

G:\Program Files~InMage Systems>Application —discover —s 2nd -t defileserver —app fileserver

Command Line: Application —discover —s 2nd —t drfileserver —app fileserver

Running wunder the user: APP.DEVXSRU.NET“Administrator

Process ID: 2628

Getting target protected Uolumes from CH

sesesesest BourcesTarget Drive Pair OQutput From CR: M=M,

o6 Found following replication pairs from Source Host = 2nd to Target Host : drfileserver
ir 1 M=H

source volume: M
target volume: M

K:z/Retention 4-D48BF542-7AB6-6A4A-B697AB6B2206E

748/ M cdpul . db

Persisting the retention log configuration of the discovered volumes: drfileserver

C:“\Program Files“InMage Systems}

Figure 96:

8.2 VXreplication

Step 88.0pen the CX Ul and click on “Volume Protection” expand the “Cluster Group(s) Volumes” to
select the clustered source volume and click on “Start Replication”
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Volume Protection: Source Site

Logged in as 'admin’ - Logout
Source | Target

Protected Drives

Server Pri Volume F5 Applicatiol

Primary Drives
[ 2o

EJ 15T

B DRFILESERVER

B Cluster Group(s) Volumes

Server Pri Volume F5 Application Capay|
5] c'”“;i‘;ﬂ' g;.-c;i E-FOUP 7 K NTFS Unknawn 107
Is CIust—:r_Ef«D. G’I"ICI—I:IE.L:_‘I:CIJF 2 L WTES b 107
§ Clustgzi‘:‘i SR?E:‘IFI ;:_Fc”p H M { Maw Volume ) NTES Unknawn 1€
W MTFS Unknown 104
o c'“i;i‘;rs g;?t'f_pi ;_:Trs"'p 3 o) NTES Unknawn 107

_ Start Replication | Reset

Figure 97:

Step 89.This will open up the next screen, select the clustered volume and click on “Next” to continue

Volume Replication: Cluster Setup

Cluster: eap
ICluster Group: croup =

Configured Cluster Drives

Primary Server Primary Volume
Finish :' Remove Reszet Cancel :'
Unconfigured Cluster Drives
Server Pri Volume F5 Capacity {Bytas)
2ND, 15T M NTFS 16417732
_ Next | _ Reset |

Figure 98:



Step 90.The target screen opens up, expand the standalone target host to select the target volume with

save drive mapping and scroll down to set the “Replication options”

Cluster: BAD
Cluster Group: Group 3

Drive: M
Capacity: 16417792

Select a target WAN volume

WAN Server Volume Capacity {Bytes)

IND

15T

= orerLeserRvER
¢ | DRFILESERVER 3 NewValums ) 5428357
¢ | DRFILESERVER K 1071627
T Bt ETRen o ume ] 1052803
@  DRFILESERVER M [ New Wolums ) 16417
{3 | InMageProfiler P 21920

Figure 99:

Step 91.Select a desired “Process Server” and scroll down.

Select Process Server ) )
IMITS234.INMAGE.IN (10.0.1,234) Mumber of Pair Configured
IMITS245.INMAGE.IN (10.0,1,245)

Figure 100

Step 92.Enable the “CDP Retention” option, the rest are optional.

Replication Options
[T | Secure transport from Source to InMageCH
[T | Secure transport from IntMage CX to destination

Sync optons: |Fast  «

Use compression: | C¥ Based Compression ‘;I
[Overrides existing 1-N replication pairs)

Add to volume consistency group: I Hew Mblume Group - i

COP Retention

Enable COP Retention option

Automatic Resync OpHons

Start between hours |13 : Joo and |6 : [on after waiting !30
minutes, (All imes are local to CX)

Submit Cancel '_ Reset |

Figure 101:
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Step 93.Define the retention policy (time based, space based or a combination) then click on “Submit”
to proceed to the last screen.

Pair Details
Sarver

2ND 15T

Retention Logging Palicy
Retention Policy
Retention Log Size

Unused Space

Retain changes upto

Retain changes upto the (time)

On insufficient disk space

Log data directory

Configure Threshold for Alerts

Alert when disk space utilization reaches

Volume Protection: Retention Options
Logged in as 'admin’ - Logout

Pri Volume Remote Server

M DRFILESERVER

Roll-backward
0.00 (MB) Current Retention Log Size

256.00 [MB)

| | I I'v'IE"I {Cannot be less then 256 MB)
|+ (Days) I {hrs.}

& Purge older retention logs

& Pause differentials

K:\Hetentioniogs

{Eg:- K:\log_data)

H.K.L are drives suggested for storing rollback log files.

Submit | _Cancel |

Volume

0.00 (MB)

Figure 102:

Step 94.Select the clustered volume and click on “Finish” to start the replication pair

Cluster: eap
Cluster Group: croup 3

Configured Cluster Drives

Volume Replication: Cluster Setup

i ZND, 15T

Primary Server

Primary Volume

Unconfigured Cluster Drives

Finish || | Remove |

M

Pri Volume FS

izl |

Reset | | Cancel |

Capacity (Bytes)

Figure 103:
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Step 95.Click on “Protection Status” to monitor the replication pair. The replication pair starts from
Resyncing (step 1) then move to Resyncing (Step 2) and finally reaches “Differential Sync”

Protection Status
Logged in as 'admin’ - Logout Server Time: Jul-11-2008 08:01:48)
Volume Protection Status
Resyncs In i . 2 5
2 Resync In Transit | Differentials Left Resync  View

Server Volume Group Tran(s:ﬁs)teul Step? (ME) (ME) Resync progress RPO Status Required | Details
Cluster:BAD, Group:Group 3 M Resyncing [Ste
Servers Valumz M 0 0 0 0% 0 s T Z =5
15T,2ND->DRFILESERVER .

Figure 104:

!
N Caution:

You will need to enable CDP retention for all VX replication pairs
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8.3 Consistency

Consistency tags can be issued either through CX UI or through CLL

Through CX Ul

Step 96.Set a new FX job with active node as “Source” and standalone target host as the “Destination”

then select the FX template as “FileServer Consistency”, then click on “Next” to continue

File Protection Wizard: Replication Pair

Logged in as 'admin’ - Logout

Replication Hosts

:;:l;a L Clustened FileSeiver
Job Description: Con=istency
Source Destination
Host Host
(& | 2ND [Windows] | 2ND [Windows]
{0 | 15T [Windows] {3 | 15T [Windows]
{ | DRFILESERWER [Windows] (¥ | DRFILESERVER [Windows]
Directory Directory
I I
FieServer Consistency _ﬂ
Next-> | Cancel |

Figure 105:

Step 97.The Job Options screen opens up with all the required fields filled up; scroll down to observe
the source pre script filled up. Do not change any settings, click on “Finish” to continue

ST T =T LT e TMMTULES Pas550

Send E-mail alert iFlE minutss passed without jeb progress

(5]
-
n
i
iti
Il
E
il
o
2
i
fal
=

-
"
o

[
o
15y
2
i

T
=)

i

|
|

i
(5]
T

i
=

SpphTag -Spp FisServer-s ZND -t DRFILESERVER

Pre swscution script pathnzms :::estinaticn:fl

Past execution script pathnams :::Estinaticn:il

Catch All job meodifier—supsr for power users only

=- Back Finish -= Cancel |

Figure 106:
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Step 98.Consistency job is set to execute every six hours by default, you may choose to change this

through the “Group Schedule”. Click on “Finish” to save the job

File Protection

Replication Jobs

[:E_ Application
" §

Name
Rum orger 1

Clustered
& FileServar

Legged in as 'admin’' - Logout

Group Schedule
Schedule Type Schedule Time
Run Every & Hours

Set Schedule |

Source :
st Source Directory Target Host
C:Ap
2ZMND Fil DRFILESERYER
Systemsifziloveridats
_Details | Remove | Cancel |

Add Job |

Finish

Target Directory

C:\Pragram
Files\InMage
Systemszlifziloveridata

Figure 107:

Step 99.Click on the “Protection Status” to monitor the VX replication pair, discovery and consistency

jobs.

Protection Status
Logged in as ‘admin’ - Logout Server Time: Jul-11-2008 08:36:2
Volume Protection Status
Resyncs In o " :
Rasync In Transit | Differentials Left Resync | View
Server Valume: Group Tran(s’\:as)tepl iy ) Resync progress RPO Status e | Dt
Cluster:BAD, GroupiGroup 3 |y v
Servars bl Voluma M o o o NA 0.35 minutas Diffzrantizl Syne no| &
15T ZND->DRFILESERVER
(Snapshat / Recovery / Rollback) Pair Status
Host | Snapshot / Recovery / Drive Start | End Expected Actual Info
Hestd i Rollback Driva e [ roarsl e | e | ety Pk | e PReRE| o |
File Pratection Status
= Source = Scheduled Jab
Filter Jab Description Application Status one | source Directary Target Host Target Directory Tvos GIn b0 e ek
Set .- - =
= Ssizot B === = Seiect [H | S2e H Seizol
_Clear |
ey C:\Program C:\Program
Consistency... Sl Completed 2ND | Files\InMage DRFILESERVER | F ge Run Every | 7 7 25 0
FilaSarver 12 \
Systemsifailoveridata failover\dats
Clustarsd . S on
Discovery... e Completes 2ND | Files\InMage DRFILESERVER Fi H s 2z o
ileSarver ) Demand
Systemsifzilovericata Sy
Delete ol job

Figure 108:
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Through CLI

Consistency can also be executed through the source (active node) command prompt. Access the
command prompt and navigate to the VX agent installation folder to issue the following command

Application —app fileserver —applytag —s <name of the source host> -t <name of the
target host> —-Bookmark ‘“<Name of the event>"’

C:“Program Files“InMage Systems*Application —app fileserver —applytag —s 2nd —t defileserver —bhookmark "My Tag"
C:“Program Files\InMage Systems“Consistency>S3ETLOCAL
C:\Program Files tency>REM Set PATH

C:“\Program Files encyrset PATH=C:\UINDOWS“\system32;C:\WINDOUS ; C: \UINDOWS\Systen32\WUbem;C:\Progran
Files~InMage Systems>consistencyss..;C:\Program Files\InMage Systems~consistencyn;

C:~Program Files:InMage Systems\Consistency>REM Set Application Name and Tag name
C:“Program Files“InMage Systems“Consistency>set VOLUMES="m:;"

Figure 109:
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9 Failover

9.1 Pre-requisites for failover or failback

e Ensure target volume drive letter or mountpoint is same as that of Source drive letter or
mountpoint when setting the replication pair.

e For cluster File Server, when performing failover through CX U], it is required that FX agent service
of production server or target DR server must be running under domain administrator or domain
user that was created for failover job.

e For clustered File Server, ensure that the network name resource of the production file server is
online else failover might not be successful.

"!'n) Notes:

“-useuseraccount” option is not applicable for CLUSTER. If user specifies “—useuseraccount”, it will
be ignored.

File server failover does not support web sharing

To restore folder icons after a failover, the respective icons need to be replicated to the path on DR
file server that is identical to the path on production file server

Cluster File server failover is supported only for single network name. Failover of file shares having
multiple network name dependencies is not supported.

For Windows Vista and Windows Server 2008, if MS Shadow copy provider is not properly installed,
VACP will hang as VSS will take time to send the response to VACP. When VACP fails, look at the
Application event log for more information
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9.2 Planned through CX Ul

Step 100. To perform a planned failover through CX U], click on “File Protection-> New Job

Group Wizard” to set the FXjob

File Protection

Logged in as 'admin' - Logout

Applications

Clustered FileServer

Displaying 1 to 1 {of 1 Applications)

New Job Group Wizard |

Manage Templates |

Figure 110:

Step 101. Click on “Add Job” on the next screen

File Protection

Logged in as admin - Logout
Replication Jobs

F ] e
[: = Application | Source Target TaigEk Dty

Mo Moot Source Directory Hoct
MNo jobs aoded el

Cancel |

 Add Job |

Figure 111:
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Step 102. Select the active node (clustered source host) as the “Source” and standalone target
host as the “Destination”, Select the FX template as “FileServer Planned Failover” and click on
“Next” to proceed

File Protection Wizard: Replication Pair

Logged in as 'admin' - Logout

Replication Hosts

::I:\i;atiun | Clustered FilaBerver
Job Description: |
Source Destination
Host Host
{3 | 2ZND [Windows] {3 | 2ND [Windows]
) | 15T [Windows] {3 | 15T [Windows]

=

¢  DRFILESERVER [Windows] DRFILESERVER [Windews]

Directory Directory

| = |
_Next-> | _Cancel |
Figure 112:
Step 103. The “Job Options” screen opens up, scroll down to “miscellaneous options” to add

the —virtualserver <name of the virtual server> switch to the end of the source pre script and

target post script as given in the picture below. Click on “Finish” to continue

TTOTOE (SUUTEE [
Send RPO alert iFl-:- | minutes passad

Send E-mail alert iFI:S_

Prz execution script path m;l-t DRFILESERVER -builtin -t=g NONE -virtuziserver log st'csé

...... T— T

Post execution script patl

Pre execution script pathname :::estinsticn:il

LESERVER -tusitln -tzg PLANNED -virtuzsarver logistic]

Post execution script pathname {destin ticn_:h

Catch All job modifisrj—super for power Wsars only

<- Back | |_Finish-> | _cancel |

Figure 113:

‘!LI’J Notes:

Adding the —virtualserver switch is specific to clustered file server.
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Step 104. The job is set to execute “On Demand”, click on “Finish” to save the job.

File Protection

Logged in as 'admin’ - Logout

Group Schedule
Schedule Type Schedule Time
Once At On Demand

Set Schedule

Replication Jobs

[:B_ Application | Source
" |

Mame Host Source Directory Target Host Target Directory
Run erder 1
Ehictead C:"Program C:'\Pregram
[ =il Se_r\.-:r 2ZND | Files\InMage DRFILESERWER | Files\InMage
1= = Systems'failoveridata Systems 1fziloveridata
_ Details ' Remove | Cancel
_Add Job |
_ Finish- |
Figure 114:
Step 105. Start the job through “File Protection” screen to perform a planned failover from

clustered file server to a standalone file server. You may monitor the failover progress through the

“Protection Status” screen.
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9.3 Planned through CLI

Planned failover can also be performed through CLI. Access the active node’s command prompt and
then navigate to the VX agent installation path to issue the following command

Application —failover —planned —s <name of the clustered source host> -f <name of the
standalone target host> —-app Fileserver —builtin —virtualserver <name of the virtual
server> —-tag none

G:~Program FilessInMage Systemsl>Application —failover -planned -s 1st —t drfileserver —app fileserw
iltin —virtualserver logistics —tag none

log: =z [P addres 18.8.152 .48

drfileserver IP addre =1@.8.152.4@8

Command Line: Application —failover —planned -s 1st -t defileserver —app fileserver -builtin -virtua

lserver logistics —tag MONE

Running under the user: APP.DEVESRU.NET-Administrator

Process 1Dz 2724

Found the virtual server : logistics
Virtual server [logistic des in Group :Group 3

Shared Resource Name Local Path Volume MountPt Mame

Quest_res M:\Gues
fAccount ing_Res M:ivAccounting

Exported Registry file successfully.

Figure 115:

At the end of the command the output is displayed enclosed within “Important Information”. This is
the command that has to be executed on the target console to complete the planned failover.

e The actual tag to failover to is : FileSystemd87767f2
reenconnoaoonanooaee [MPORTANT  INFORMATION
Please run the following command on the Target Host to complete failover

Application.exe —failover —-planned —app fileserver -z 1zt —t defileserver —builtln —tag FileSystemd8
?P67F2 —virtualserver logistics

‘H*X*Suc ssfully finished failover at sourcesssx

Figure 116:

Then copy the folder “<VX install path>\Failover\Data” folder to the same location on the target host.
Switch to the target command prompt to issue the command.

C:nProgram Files\InMage SystemsilApplication.exe —failover nned —app fileserver —s lst -t drfile
server —huiltln -tag FileSystemdB87767f2 —wvirtualserver logistics

logistics IP address = 18.8.152.32

drfileserver IP address = 18.8.152.48

Conmand Line: Application.exe —failover —planned —app fileserver —s 1st —t drfileserver —builtIn —tal
g FileSystemd877?67f2 —virtualserver logistics

Running wunder the uwser: APP.DEVESRU.NEI-Administrator

Process ID: 1768

Getting target protected Volumes from CX

wxxxx SourcesTarget Drive Pair Output From CH: M=M.

sesesese Found following replication pairs from Source Host = 1st to Target Host @ dwfileserver
air = M=M

source volume: M
target volume: M

h:/poportuwet f51cc4ldf b D48BF542-7086—6A4A-B697N86B2206EY 40/

Figure 117:
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9.4 Unplanned through CX Ul

!
" Caution:
Ensure that the Discovery and Consistency jobs have successfully completed at least once after
any change in the configuration to ensure that target node has latest information.

Step 106. Setup an FX job with “Source” and “Destination” as the standalone file server (since
the production server is down). Select the FX template as “FileServer Unplanned Failover”

File Protection Wizard: Replication Pair

Logged in as 'admin’ - Logout

Replication Hosts

Application I
Name:

Job Description: I

Destination

Source
Host Host
) | 2ND [Windows] ) | 2ND [Windows]
¢ | 15T [Windows] ¢ | 15T [Windows]
(& DRFILESERVER [Windaws] & DRFILESERVER [Windows]
Directory Directory
I |
I | FiieServer Unpiznned Failover =l I
Mext -= Cancel
Figure 118:
Step 107. The Job Options screen opens up, scroll down to miscellaneous options to append the

switch —virtualserver <name of the virtual server name>. Click on “Finish” to proceed

Send E-mail alert ifli minutes passed without jeb progress

Pre sxecutien script pathnamsl

Post exscution script pathnamsl

Pre executien script pathname ::cestinaticn:il

Post executien script pathname [destinati n::lDFiFI_EEER‘JEH—:-. tin-t=g LATEST -virtuslserver logistics

Catch All job mc:iﬂirl =r for power users only

<- Back Finigh -> Cancel

Figure 119:



Step 108. The job will be set to execute “On Demand”. Click on “Finish” to save the job. You
may start the job through the “File Protection” screen to perform an unplanned failover.

File Protection

Logged in as 'admin’ - Logout

Group Schedule
Schedule Type Schedule Time

Once At On Demand

Set Schedule

Replication Jobs

[:B_ Application
"

Name Source Host Source Directory Target Host Target Directory
Run order 1
Clustered C:\Program C:\Program
[ " | DRFILESERVER | Files\InMage DRFILESERWER | Files'InMage
FilzServer = ; B \
Systems1\failover\data Systems1\failover\data
Details Remove Cancel
Add Job
Finish
Figure 120:

You may monitor the status through the “Protection Status” screen on the CX UL
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9.5 Unplanned through CLI

To perform an unplanned failover through CLIL, access the target host’s command prompt to issue the
following command

Application —failover —unplanned —s <name of the clustered source file server> -t <name of
the standalone target server> —app Ffileserver —tag LATEST —builtin —virtualserver
<name of the virtual server>

C:“Program Files~InMage Systemsl>Application —failover —unplanned —-= 1st -t drfileserver —app filese
(ruer —tag LATEST -builtin —virtuwalserver logistics

logistics IP address = 1B8.8.152.32

drfileserver IP address = 18.0.152.48

Command Line: Application —failover —unplanned —-s 1st —t drfileserver —app fileserver —tag LATEST —h
uiltin —virtualserver logistics

Running under the user: APP.DEVXSRU.NET-Administrator

Process ID: 2168

Getting target protected Uolumes from CH

s SourcesTarget Drive Pair Output From CX: M=HM.

sxxxx Found following replication pairs from Source Host : 1st to Target Host : drfileserver
Pair = M=H
source volume: M
target volume: M

Figure 121:
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10 Failback

A failback is the reverse of a failover. Failover can only be performed to a standalone server. However,
to perform a failback to a clustered server, it will be turned into a standalone server during the failback
process. Once the failback is complete it will be turned back into a clustered server.

Step 1. Convert
Clusterto >

Step 5. Convert

SianZ Bsusgs —»| Step3.Discovery —»| Step4.Failback »| Standaleneto

Standalone replication Cluster
Figure 122:
10.1 Cluster to standalone
Step 109. Access the active node’s command prompt, and then navigate to the VX agent

installation path to issue the following command

Clusutil —prepare clustertostandalone: <name of the active node> -shutdown <name of
the passive node>

|C:\Program Files“InMage Systems>CluslUtil.exe —prepare ClusterTofStandalone:lst —shutdown 2Znd

Connected to [2nd1 SCHM
Waiting for the service [svagents] to stop

Figure 123:

After the command is execute the active node will turn into a standalone server while the rest of the
nodes are shutdown.

“!Lr'} Notes:

For Windows Server 2008 cluster, you will need to perform onlinedisk operation after the node
restarted as the result of the above step.

In Windows Server 2008 cluster, after server restarts, cluster disk will be offline and cannot be
used until it becomes online. You may use the “ClusUtil.exe —onlinedisk” command to bring all
the disks online.

When you need only selected clustered disks online, you may access the cluster management
interface and take the other disks offline
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10.2 Reverse replication

Step 110. Proceed to set a reverse replication from standalone file server to the active node which

is turned into another standalone server (original source host).

Protection Status

Logged in as 'admin’ - Logout

Server Time: Jul-11-2008 12:04:13

Volume Protection Status

feamcsln Resync In Transit  Differantials Laft Resync | View
Server Volume Group Tran(s;ﬂt;]tepl Stepd (MB) (HB) Rasync progress RPO Status Required | Details
DRFILESERVER->15T "":'\"_"}‘};‘”’”" Velume M 0 0 0 57.48% 0,42 minutes Resyncing (Step 1) YES
Figure 124:
10.3 Discovery
Step 111. Set the FX job to replicate shared information specific to the VX replication pair from

the DR file server to the production file server. Select the “Source” as original target and
“Destination” as the production file server (now a standalone server). Select the FX template as

“FileServer Discovery”

File Protection Wizard: Replication Pair
Logged in as 'admin' - Logout
Replication Hosts
Application Clioteed Fiatarear
Name: : = 2=
Job Description: IE;-E_C:'.'EPJ-' fzilback)
Source Destination
Host Host
) | 2ND [Windows] O | 2ND [Windows]
{7 | 15T [Windows] (& | 15T [Windows]
{s} | DRFILESERVER [Windows] {7} | DRFILESERVER [Windows]
Directory Directory
I I
l_: eServer EEC:-'._'EI",'. :1
Next -= .. Cancel

Figure 125:
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Step 112. The Job Options screen opens up with all the required fields filled up automatically,

scroll down and click on “Finish” to continue.

Send RRO zlertif |3 | minutes pass=d

Send E-mail zlart ifIE. migyt=c pazced withontjob proorss

i

re execution script pathna -EI'C:".P-'-D;-'EI"’ FizsinM=ge Systemz1\Apphcation exe” -dizcoy

=)

ost executien script pathnams

Pre execution script pathname ::cestinaticn:il

Post execution script pathnzme [destin

Catch &ll job mcc'iﬁerll— for power usars onfy

<- Back | _Finish-> | Cancel |

Figure 126:

Step 113. The next screen opens up, the job is set to execute “On Demand”. Click on “Finish” to

save the job. You can start the job through the “File Protection” screen.

File Protection

Logged in as 'admin’ - Logout

Group Schedule
Schedule Type Schedule Time

Clnce At Ctn Demand

_Set Schedule

Replication Jobs

Target

Source Host Source Directory Hast

M Target Directory

[:g_ Application

Rur order 1

C:\Program

o E:E?EEE DRFILESERVER 15T | Files\InMage
A ystems 1ifziloveridata Systems 1'fziloveridata
Detailz Femove Cancel
Add Job
Finish
Figure 127:
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10.4 Failback

Step 114. Once the Discovery job is completed, proceed to setup another FX job for the failback.
Select the source as the DR file server (original target) and Destination as the newly created standalone
server (once clustered file server). Select the FX template as “FileServer Planned Failover” and click on

“Next” to continue.

Logged in as "admin' - Logout

Replication Hosts

File Protection Wizard: Replication Pair

(¥ | DRFILESERVER [Windows]

Gppisitm ICIustenedFiIe server
Mame:
Job Description: |f3i|b30k
Source Destination
Host Host

" | DRFILESERWER [Windows]

18T [Windows] v 15T [Windows]
| 2MD [Windows] i 2D [Windows]
Directory Directory
I |
File Server Planned Failback =
Mext -= Cancel

Figure 128:
Step 115. The “Job Options” screen opens up, scroll down to “miscellaneous options” to add

the —virtualserver <name of the virtual server> to both source prescript and target post

script. Then click on “Finish” to continue

TR P JTerCIr LLLLLLL" L9-Fo nr- bRy -an

Send E-mail alert i'FI5 minutes passed withoutjob progress

Pre execution script pathn meF'LESER"v’ER

-t 15T -builtIn tag MOMNE -virtualserver logistics

Post execution script pathnamel

Pre execution script pathname (destination

Post execution script pathname (destinati

n:]FSER‘uER -+t 15T -builtIn tag PLAMMNED -virtualsernver logistics

<- Back

Catch all job mndiﬁerl“s'-'PEf for povwer users only

Finish -= Cancel

Figure 129:
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Step 116. The job is set to execute “On Demand”. Click on “Finish” to save the job and start the
job through “File Protection” to perform a failback.

File Protection

Logged in as 'admin’ - Logout

Group Schedule
Schedule Type Schedula Time
Once At Cn Demzng

Set Schedule

Replication Jobs

F | -
[:lj Apﬁh:r::un Source Host Source Directory T:;gsit Target Diractory
Rurn order I
Cliustared C:\Pragram Z:\Program
&) Fil'-S=-n-=hr DRFILESERVER | Files\InMage 15T | Files\InMage
il Swstems 1\failoveridats Systems 1\fziloveridats
Details || | Remove Cancel |
Add Job
Finich
Figure 130:

You may monitor the progress on the “protection status” screen on the CX Ul

10.5 Standalone to cluster

Step 117. After failback, access the standalone production server to convert it back to a clustered
server. Access the command prompt, and then navigate to the VX agent installation path to issue
the following command

ClusUtil.exe -prepare StandalonetoCluster <standalone name>

C:s\Program FilessInMage Systems>clusutil.exe —prepare —StandalonetoCluster 1st

Figure 131:

This will restart the machine and restore it to its former clustered state. Then start all passive nodes
that were shutdown earlier. Access the cluster administrator interface to bring the fileserver group
online. Verify that all the cluster resources are coming online and client can access the cluster.
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Part 3: Clustered Production Server
and Clustered DR Server

This part explains protecting File Server in an environment where production server and DR server
both are in clustered environment.
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11 Cluster to Cluster Environment

This part of the document explains protecting a clustered file server to another clustered server. The DR
cluster needs to be prepared to act as a target for the replication pairs.

Prepare Protect Recovery
*Ensure that DR cluster has the *Configure File server discovery *Take Offline the Network Name
same volumes are of the Set VX replication pairs through Resouces of source cluster
production cluster. cX Ul slssue consistency tag on the
*Convert DR cluster to standalone sConfigure consistency job. source volumes

*RollBack target Volumes

*Convert Standalone DR server to
Cluster

*Start passive nodes manually

*Create File Share Resource in
Target

Figure 132:

!
"% Caution:

After setting the replication pair, again run the discovery job as discovery job gather the file
share information specific to the protected volume.

11.1 Prepare:
The prepare step describes steps to prepare the DR cluster before setting VX replication pairs.

You will first need to offline the Network Name Resources of the DR cluster to restrict any further
changes to the volume on the DR cluster.

Convert DR cluster to standalone DR server using the clusutil.exe command under the Vx agent install
directory. All passive nodes on the DR server will be shut down and the active node goes down for a
reboot and comes back as a standalone DR server. This enables you to set VX replication pairs.

clusutil._exe -prepare clustertostandalone:<active node> -shutdown <Passive
node>
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‘!Ll‘) Notes:

For Windows Server 2008 cluster, you will need to perform onlinedisk operation after the node
restarted as the result of the above step.

In Windows Server 2008 cluster, after server restarts, cluster disk will be offline and cannot be
used until it becomes online. You may use the “ClusUtil.exe —onlinedisk” command to bring all
the disks online.

When you need only selected clustered disks online, you may access the cluster management
interface and take the other disks offline

11.2 Protect

Step 118. Configure a file server discovery job through the CX Ul After the FX job is successful,
proceed to set the VX replication.

Step 119. Set volume replication from production cluster to standalone DR server with CDP
retention enabled. Ensure that you replicate between same drive letters.

Step 120. Once the replication pair reaches “Differential Sync”, configure the file server
consistency job. This consistency job issues vacp tags on the source volumes at regular intervals.
These tags act as markers while performing a recovery operation.

l\
A Caution:

You will need to enable CDP retention for all VX replication pairs

11.3 Recovery

Step 121. Offline the “Network Name Resources” of production cluster to avoid further changes
on the clustered volumes.

Step 122. Issue consistency tag on the production cluster
vacp =V K:; H: -t ““<name of the tag>"’

Step 123. Rollback target volumes through the CX UL

Step 124. Convert the standalone DR server back to its clustered form using the clusutil.exe

command
clusutil.exe -prepare standalonetocluster :<Active node name>

You will then need to start the passive nodes manually

Step 125. Create File share resource on the DR cluster
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